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TECHNICAL SUPPORT

How Do You Contact Emerson for Technical Support?

For help on setting up Liebert SiteScan Web or any other monitoring product, contact Emerson’s 
Software Technical Applications Support Center at:

UNITED STATES 1 800 222 5877

FRANCE +33 (0) 1 46 87 51 52

GERMANY +49 (0) 89 99 19 220

ITALY +39 (0) 2 98250 324

NETHERLANDS +31 (0) 475 503333

UNITED KINGDOM +44 1628403200

EUROPE +800 11554499

ASIA +800 11554499

AUSTRALIA 1 800 147704

NEW ZEALAND 0 800 447415

WORLDWIDE

1 614 841 6755

FAX: 1 740 833 8631

All Products: http://www.liebert.com
Liebert SiteScan Web: http://sitescan.liebert.com

E-mail: liebert.monitoring@emerson.com

http://www.liebert.com
http://sitescan.liebert.com
mailto:liebert.monitoring@emerson.com
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1.0 WHAT IS LIEBERT SITESCAN WEB?

Liebert SiteScan Web uses a network of microprocessor-based control modules to monitor and control 
Liebert precision cooling, power, UPS and other critical equipment. 

Liebert SiteScan Web enables the user to monitor and control equipment in a single building, an 
entire campus or a network of facilities around the globe. A Liebert SiteScan Web system utilizes a 
Web-based server running Microsoft® Windows® Server® 2003 x64 or Windows Server® 2008 x64 and 
a conventional Web browser to gather information, change operating parameters, run reports and 
perform similar functions on various types of critical equipment.

1.1 How Does Liebert SiteScan Web Work?

A central Web-based server communicates with control modules and generates Web pages that may 
be accessed using a conventional Web browser. Liebert SiteScan Web allows you to gather 
information, change operating parameters, run reports and perform other critical monitoring system 
functions on equipment in a single facility or in dozens of locations.

The Web server and Liebert gateway communicate over an Ethernet network. The Liebert gateway 
communicates to the Liebert control modules using the Control Module network (CMnet) and the 
ARCnet156 protocol. The control modules communicate with the Liebert environmental and power 
equipment using the Information Gathering Network (IGMnet) or to contact closure equipment using 
a signal cable. 

Customers access the information presented as a result of these functions using a Web browser. 
Internet Explorer is the browser supported by the Liebert SiteScan Web server.

1.2 Purpose of This Manual

This manual is intended to serve as an operation manual for Liebert SiteScan Web. The manual 
presents instructions and illustrations to assist operators with day-to-day activities that may be 
required for managing a Liebert SiteScan Web system.

Functions typically performed by an Emerson Network Power Liebert Services representative are not 
covered in this manual:

• Installing the Liebert SiteScan Web software
• Connecting equipment that will be monitored by Liebert SiteScan Web
• Configuring equipment in the Liebert SiteScan Web software
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2.0 WHO CAN BENEFIT FROM LIEBERT SITESCAN WEB?

Any industry operating devices utilizing the BACnet protocol can benefit from using Liebert SiteScan 
Web to protect valuable equipment, data and other assets in the event of power or mechanical failure.

Different people in an organization need to know different things about the operation of critical 
facilities. Liebert SiteScan Web has the unique ability to be tailored to provide various levels of 
information to those in your organization responsible for system operations.

Examples include personnel running a data center, an entire facility, an enterprise-wide network or a 
building management system (BMS).

2.1 Data Center

Those responsible for the operation of large data or 
telecommunications centers must be aware of all protective 
infrastructure within these facilities.

They need up-to-the minute information that will allow them 
to keep systems operating—no matter what the situation.

2.2 Facility

These people are interested in the performance of critical 
operations in the context of an entire facility.

Events in one area of a facility can directly affect the 
operation of critical systems in another and vice versa.

2.3 Enterprise

Multiple sites mean multiple responsibilities for those in 
charge of an enterprise-wide network and communications 
system.

They need to know the status of many remote locations to 
keep the entire organization working smoothly.

2.4 BMS Interface

Liebert SiteScan Web can interface with an existing building 
management system (BMS) or other facility supervisory 
equipment for expanded monitoring capability.
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3.0 WHAT IS REQUIRED TO USE LIEBERT SITESCAN WEB?

Visit the Liebert Web site at http://sitescan.liebert.com for the latest product information. The Web site 
always has the most detailed and up-to-date information on system requirements and Liebert 
SiteScan Web’s capabilities.

3.1 Liebert SiteScan Web Server Requirements
Liebert SiteScan Web is based on server/thin-client architecture, designed around the open standards 
of Web technology. The Liebert SiteScan Web Server communicates using ASHRAE’s BACnet/IP 
protocol and is accessed using a Web browser over the owner’s intranet or external through the 
Internet. The intent of the thin-client architecture is to provide operators complete access to the 
system via a standard Web browser. The thin-client Web browser Graphical User Interface (GUI) 
supports Microsoft® Internet Explorer (version 7.0 or later). The Liebert SiteScan Web server 
software supports Microsoft® Windows® Server® 2003 x64 or Windows Server® 2008 x64.

System configuration requirements differ slightly for the Liebert SiteScan Web server and any 
associated client workstations. Table 1 shows the recommended requirements for the server and 
client workstations running on a Microsoft Windows Platform.

Table 1 Minimum requirements - Liebert SiteScan Web server* and client workstations

Feature Minimum Server Requirements* Client Workstation Requirements

Operating
system

Microsoft® Windows® Server® 2003 x64 or Windows 
Server® 2008 x64 Windows XP or later

Browser Microsoft Internet Explorer v7 or later with 
Sun Systems Java (www.java.com)

Microsoft Internet Explorer v7 or later with Sun 
Systems Java (www.java.com)

Computer
system
(CPU)
speed

The more simultaneous users on a system, the faster the 
CPU speed required to maintain good user response time.
For a system with:
• One or two active users, a 2 GHz CPU should provide 

adequate performance.
• Three or more active users, select a 3 GHz or faster CPU.
• 10 or more active users, consider multiple CPUs. Moving 

the database to another computer is more economical than 
running both Liebert SiteScan Web and the database on a 
multiple CPU system.

Dual-core processor

System 
memory

6GB system memory recommended to eliminate excessive 
swap file usage. The responsiveness of larger systems will 
benefit directly from more memory.

—

Hard
disk

space

80GB free hard disk space available for Liebert SiteScan Web
Note: A SCSI hard disk interface is recommended for users 
making extensive use of alarms or historical trends.

10Mb of free hard disk space available for 
caching images

USB
ports

USB ports available for system backups, preferably front-
mounted to avoid disturbing computer room cabling. —

CD
drives

CD-ROM drive (CD-RW drive recommended for alternate 
backup purposes) —

Mouse/
keyboard 2-button mouse / 104-key keyboard 2-button mouse / 104-key keyboard

Remote
control

software

For large systems with remote sites, Liebert strongly 
recommends using remote control software—for example, 
Windows Remote Desktop, VNC or PC Anywhere—to allow 
Liebert service engineers to access the server remotely.

—

Display
SVGA display card and monitor that support a 
resolution of 1024x768 pixels with True Color 
(32-bit) or better

SVGA display card and monitor that support a 
resolution of 1024x768 pixels with High Color 
(16-bit) or better

Network 10/100 Mbps Ethernet network card
Network connection capable of reaching the 
server—for example, an Ethernet network card 
or a dial-up modem connection.

* Liebert SiteScan Web should have its own dedicated server. Having other web server applications—such as Apache or IIS—running on 
the same machine will cause conflicts. 
Running the client-side browser on the server will add to the server’s load; to compensate, increase CPU and memory headroom.

http://sitescan.liebert.com
www.java.com
www.java.com
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4.0 TYPICAL LIEBERT SITESCAN WEB SYSTEM

A typical Liebert SiteScan Web system may include the components shown in the figure below.

Liebert 
SiteScan 
Web 
Client

Server Software and Client License
• Liebert SiteScan Web Server - A dedicated computer 

running Liebert SiteScan Web server software, including a 
database that stores system configuration, custom graphics 
and equipment interfaces. For hardware and operating 
requirements, see Table 1.

• Liebert SiteScan Web Client - A workstation on the 
network that uses a conventional Web browser, such as 
Internet Explorer, to access the Liebert SiteScan Web server. 
The workstation may also be used for functions not related to 
Liebert SiteScan Web.

• Ethernet Backbone - The customer’s existing network, 
including router and wiring or wireless connection gear.

IGM Interface Control Modules
• Liebert SiteLink units - Control modules that provide IGM 

communications between the Liebert environmental and 
power equipment and the Liebert gateway.

Third-Party Interfaces
• SiteTPI-E - A monitoring and control module that enables 

non-Liebert Modbus devices to be incorporated into the 
Liebert SiteScan Web System; used to interface with third-
party equipment such as generators, fire suppression 
systems or competitive gear.

Input/Output Control Modules
• Site I/O Modules - A selection of modules that translate 

analog and digital signals within your critical environments. 
These modules may provide digital signals for output control.

SNMP Interfaces
• SiteIP-E - A monitoring and control module that enables 

Liebert and non-Liebert SNMP devices to be incorporated 
into the Liebert SiteScan Web System.

Liebert 
SiteScan 
Web 
Server
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5.0 OVERVIEW OF LIEBERT SITESCAN WEB

This section provides a quick look at the navigation and configuration features available through 
Liebert SiteScan Web’s buttons and tabs. 

Liebert SiteScan Web’s view buttons—GEO and CFG—logically divide Liebert SiteScan Web’s 
functionality. 

• The GEO button displays the operational status and condition of configured devices.
• The CFG button is the entry point for all setup functions.

5.1 The Liebert SiteScan Web Workspace

The main sections of the Liebert SiteScan Web window are shown in the following example.

View buttons
• GEO - Geographic tree (for status, alarms, reports)
• CFG - Configuration tree (for setup functions)

Menu buttons 
(click arrow for 
drop-down menu)

System-wide alarms
• Green: none
• Yellow: non-critical
• Red: critical alarms

Print window
Show/hide 
tree at left

Help

Back
button

TREE
(left pane) Show/

hide
menu

Shortcut 
toolbar

VIEWING 
AREA
(right 
pane)

Color-coded legend for 
system conditions
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5.2 Menus and Buttons
Table 2 shows the Liebert SiteScan Web features discussed in this manual and where to learn more 
about each.
Table 2 View buttons and menu options - summary

Feature Tab Subcategories For more information, see:

GEO View Button

Graphics — — 7.0 - Viewing Status

Alarms

View — 8.2 - View Alarms

Messages — 8.3 - Messages

Actions

Alarm Popup 8.4.1 - Alarm Popup Action

Print 8.4.2 - Print Action

Run External Program 8.4.3 - Run External Program Action

Send Alphanumeric Page 8.4.4 - Send Alphanumeric Page Action

Send E-Mail 8.4.5 - Send E-Mail Action

Send SNMP Trap 8.4.6 - Send SNMP Trap Action

Write Property 8.4.7 - Write Property Action

Write to Database 8.4.8 - Write to Database Action

Write to File 8.4.9 - Write to File Action

Enable/Disable — 8.5 - Enable/Disable

Reports — 8.8 - Alarm Reports

Trends
View — 9.1 - View an Existing Trend Graph

Configure — 9.3 - Configure Trends

Reports

View — 10.3 - View Reports

Configure — 10.4 - Set Up Report Options

Design

Create a Report 10.5 - Set Up a New Report

Report Options 10.6 - Built-In Reports

— 10.7 - Equipment Checkout

Alarm Sources, Details 10.8 - Alarms

Locked Values 10.9 - Equipment

Location, System log 10.10 - Security

Equipment Status 10.11 - Network (Only on NET Tree)

CFG View Button

My Settings
Settings — 11.1.1 - Settings

Contact Info — 11.1.2 - Contact Info

System Settings
General — 11.2.1 - General

Daylight Saving — 11.2.2 - Daylight Saving

Operators — — 11.3.1 - Set Up Operators

Privilege Sets — — 11.4.1 - Add a Privilege Set

Operator Groups — — 11.3.2 - Create Operator Groups

Services — — 11.5 - Services

Trends Display Setup — — 11.6.1 - Trends Display Setup

Trends Print Setup — — 11.6.2 - Trends Print Setup
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5.3 Informational Icons in the Navigation Tree
The icons used in the alarm viewer are shown in Figure 1.

Figure 1 Alarm icons

The icon indicates the alarm category. The icon’s color indicates severity, as shown below: 

5.3.1 Navigation Pane

The Navigation Pane may be shown or hidden, depending on the desired view. To show or hide the 
navigation pane:

Click  to toggle the navigation pane between shown or hidden. When the navigation pane is 
hidden, move the cursor across the left edge of the browser to show the navigation pane.

Click and drag the right edge of the navigation pane to adjust its width.

5.3.2 Zooming and Resizing in the Viewing Area
• Hold the Ctrl key while rolling the mouse wheel to zoom in or out on the contents of the Viewing 

Area.
• Right-click the Viewing Area and select Scale to 100% to restore the contents to their original size.
• If a graphic does not fit in the viewing area, right-click it and select Scale to Fit to make it fit the 

viewing area.
• Select Scale to 100% to return it to its original size.

Color Severity

Blue Maintenance needed

Yellow General non-critical alarm

Red Critical alarm
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5.3.3 Using Right-Click Menus

Right-clicking an item in the Navigation Tree, the Viewing Area or a property offers additional 
options and shortcuts:

5.3.4 Tree Icons and Hover Text

The navigation tree displays an icon to the left of each item to denote the type of 
item. For example:

Custom equipment icons can be set up in Liebert SiteScan Web. Right-click the 
equipment in the GEO or NET tree, select Configure, then select the icon.

5.3.5 Optional Icons

The following icons can be displayed to denote locations in the GEO tree where items were created or 
assigned.

To turn on optional icons:

1. Right-click the GEO tree.
2. Select Tree Display Options.
3. Select the desired Tree Icons.
4. Click OK.

Tree Item Viewing Area Property

Right-Clicking the items below yields the options and shortcuts

System

Area

Equipment

Schedules Schedule Groups Trend Graphs Reports Alarm Actions Privileges

Select Tree Display Options ...

... then the desired Tree Icons
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5.3.6 Optional Hover Text

Turning on hover text reveals information about an item when the cursor is held over a system, area 
or equipment icon. The information displayed depends on which hover text options selected.

To turn on hover text:

1. Right-click the tree.
2. Select Tree Display Options.
3. Select the desired Tree Hover Text.
4. Click OK.

5.4 Shortcut Toolbar

A toolbar with shortcut icons appears directly below the menu action buttons in the right pane. These 
icons provide quick access to key features—for example, move up one level in the tree, add a note, 
view a trend graph, configure an item or a maintenance schedule.

The icons vary according to the selected item. If power equipment is selected, the icons shown will 
relate only to power equipment. If cooling equipment is selected, only icons related to cooling 
equipment will be displayed. Table 3 provides a summary of these icons and where to find more 
information.

NOTE
The toolbar icons disappear in some views. They will be reappear when the mouse hovers over 
the toolbar area.

Hover Text

Shortcut toolbar
Icons vary according to selection
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Table 3 Shortcut icons

Icon Click the icon to: For details, see:
 

System Overview Move to the top level of the tree in the GEO view tree and present 
the SSWEB splash screen in the right viewing plain.

5.4.1 - System 
Overview Shortcut

 

Summary Bezel
Display summary data for a selected site and display the status of 
all equipment listed under the Area graphic.

5.4.2 - Summary 
Bezel Shortcut

 

Show/Hide Notes
Add notes about any item or toggle between the notes window and 
the previous view.

5.4.3 - Show/Hide 
Notes Shortcut

 

Area Graphic Display a floor plan of a selected item in the tree. 5.4.4 - Area Graphic 
Shortcut

 

Up One Level Move up one level in the GEO tree. 5.4.5 - Up One Level 
Shortcut

 

Maintenance 
Mode Schedule maintenance for a selected point.

5.4.6 - Maintenance 
Mode Shortcut

 

Trend Graphs View a trend graph of a selected point. 5.4.7 - Trend Graph 
Shortcut

 

Edit Page View or change the characteristics of a selected unit or point. 5.4.8 - Edit Page Icon

 

Area Edit Page
Displays Area Edit Page so the area graphic can be modified using 
same methods used to create the Area Graphic. 5.4.9 - Area Edit Page

 

Air Summary View summary page for environmental control units, temperature, 
heating, cooling, humidification, dehumidification.

7.3 - View an Area 
Graphic or Summary 
Pages

 

Power Summary View summary page of power status, input voltage, output (voltage 
and amps, load percentage, power factor.

Static Switch 
Summary

View summary page of status of each static switch (voltage, current 
and power in kVa, kW and Hz).

 

UPS Summary
View summary page of status of each UPS, bypass voltage, input 
voltage, battery condition, inverter status, output (voltage, current 
and power in kVa, kW and Hz).

 

Disable 
Notifications Enable or disable notifications for each unit. —

 Pencil (available 
only on Area Edit 
Page)

Edit unit and area names, as well as setpoints for applicable units.
5.4.10 - Pencil Icon 
(Available Only on 
Area Edit Page)

 Save changes
(available only on 
Area Edit Page)

Save changes to the configuration.

5.4.11 - Save 
Changes Icon 
(Available Only on 
Area Edit Page)

 Unlock
(available only on 
Area Edit Page)

Unlock to change the position of a unit on the floor plan. 5.4.12 - Unlock / Lock 
Units Icons 
(Available Only on 
Area Edit Page)

 Lock
(available only on 
Area Edit Page)

Save and lock a unit’s position on the floor plan.
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5.4.1 System Overview Shortcut

At any level in the GEO tree:

• Click on the System Overview icon to navigate to the highest level of the GEO tree. 
• Site icons appear below the shortcut toolbar, as shown in the following example. Click on any site 

icon to display key information in a site box—the current condition and the number of alarms, 
warnings and other conditions. 

• The Summary Bezel icon displays the same type of information for multiple sites (see 5.4.2 - 
Summary Bezel Shortcut).

5.4.2 Summary Bezel Shortcut

With a site selected in the GEO tree:

• Click on the Summary Bezel icon to display summary data for all areas in the selected site:
• Condition (overall status)
• The number of critical alarms and warnings detected, as well as messages sent
• Statistics on conditions: loss of communications, in maintenance, normal operation

• The same type of information is available at the highest level in the tree (see 5.4.1 - System 
Overview Shortcut).
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5.4.3 Show/Hide Notes Shortcut

With an item selected:

• Click on the Show/Hide Notes icon to display a notes window, as shown below.
• Enter text as desired.

The Show/Hide Notes icon changes color to indicate a note has been added to an item. The icon 
will be white if no notes are attached to the item. The icon changes to black if notes have been 
attached.
The note remains until it is deleted.

• Click on the Show/Hide Notes icon to return to the previous view.

5.4.4 Area Graphic Shortcut

With a site selected in the GEO tree:

• Click on the Area Graphic icon to display a floor plan of the selected site, as in this example.
Note: If any units have moved out of view, press and hold the Ctrl key and right-click, then 
choose Clear Unit Positions from the popup menu. Reposition units as needed.

Click on this icon ...

... to bring up this page
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5.4.5 Up One Level Shortcut

Use this icon to move up one level in the GEO tree:

• Click on the Up One Level icon to move up a level in the GEO tree—in the example above, from 
the site shown to the next higher level.

5.4.6 Maintenance Mode Shortcut

With an item selected:

• Click on the Edit Page icon, then on Maintenance Mode icon to view or change the maintenance 
schedule of the selected point. 

• The example below includes the following data:
• Description: shows the name of the selected item—for example, TPI Point 1.
• Maintenance Status: displays whether the maintenance function is Off or On.

• Maintenance Type - select one of these options: 
• Now - Click this button to change the Action button to Maintenance Now.
• Future - Click to change the Action button to Schedule Maintenance and display time and 

date options for the maintenance.
• Duration: enter the maintenance duration for the device in hours and minutes.
• If Schedule Maintenance is selected, specify the time and date for maintenance to begin.
• Action button - toggles according to the Maintenance Type selected for this point:

• Click the Maintenance Now button to perform maintenance immediately.
• Click the Schedule Maintenance button to save and activate the maintenance schedule.

• After clicking an Action button, click the OK button to confirm your choice (or Cancel to prevent 
the operation).

Action button - 
Maintenance Now or
Schedule Maintenance

Action button - 
Run Maintenance Now

Maintenance Now or Future 
(schedule for later dates)

Action button - 
Schedule Maintenance

CHECK THIS 
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5.4.7 Trend Graph Shortcut

With a point selected in the tree at left:

• Click on the Trend Graph icon to view a trend graph of the 
selected point, as in the example shown at right.

• See 9.0 - Viewing Trends for details.

5.4.8 Edit Page Icon

With a unit or data point selected in the left navigation tree:

• Click on the Edit Page icon to view or change the 
characteristics of the selected unit or point.

• Make changes as needed.
• When finished, click the Submit button for a single item (or click Submit All to save all 

changes). To cancel any changes, navigate to another page without clicking any Submit buttons.

5.4.9 Area Edit Page

With a site selected in the GEO tree:

• Click on the Area Edit Page icon to display an editable floor plan of the selected site. This permits 
moving units, renaming units and adding other custom area features.

Note: If any units have moved out of view, press and hold the Ctrl key and right-click, then choose 
Clear Unit Positions from the popup menu. Reposition units as needed

5.4.10 Pencil Icon (Available Only on Area Edit Page)
• When this icon appears in the shortcut toolbar, click to change the name of a unit or area. 
• After making the change, click the Save Changes diskette icon described in the next section.

5.4.11 Save Changes Icon (Available Only on Area Edit Page)
• When this icon appears in the shortcut toolbar, click to save changes after using the Pencil icon 

to change unit or area names or using the Unlock icon to move units around on the floor plan.
• After clicking this Save Changes diskette icon, the OK and Cancel buttons appear at the top of 

the screen, as shown in the example in the next section.
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5.4.12 Unlock / Lock Units Icons (Available Only on Area Edit Page)

To move a unit or its label on the floor plan:

• Click the Unlock icon in the shortcut toolbar.
• Click on the unit or its label and drag to the desired position.
• At the top of the window, click the OK button to save changes (or Cancel to clear any changes).
• Click the Lock icon in the shortcut toolbar to prevent users from moving the unit or its label on 

the floor plan.

Unlock, then 
click and drag 
to move label

OK / Cancel 
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5.5 Liebert SiteScan Web Features

Table 4 compares the features in versions of Liebert SiteScan.

Table 4 Features available in Liebert SiteScan Web

SiteScan 2000/
SiteScan 2W SiteScan Web v2 SiteScan Web v3 SiteScan Web v4 SiteScan Web v5

System Feature

Operating System 
Compatibility

Windows 95 / 98 / 
ME Windows NT Windows 2000 / XP Windows XP / 2003 Windows 2008 R2

32-Bit Application ✔ ✔ ✔

64-Bit Application ✔

System Security  ✔ ✔ ✔

Role Based Privileges  ✔ ✔ ✔

Standard Point-and-
Click Operation ✔ ✔

Enhanced Navigation  ✔ ✔ ✔

Client Applications ✔

Unlimited licensing  ✔ ✔ ✔ ✔

Client to Server 
Accessibility  ✔ ✔ ✔

Based on Open 
Standards  ✔ ✔ ✔

Alarm Management ✔ ✔ ✔ ✔ ✔

Reporting Functions  Formula One ✔ ✔ ✔

Time-Based Data 
Logging ✔ ✔ ✔ ✔ ✔

Enhanced Data Loging ✔ ✔ ✔

Data Graphing ✔ ✔ ✔ ✔ ✔

Hardware Base

General Specifications:
• 8-bit processors

• 2MB of memory (max)
• 19.2 kBaud (max speed)

• 32-bit, multi-
thread processor

• 2-16MB of 
memory

• 156kBaud max 
speed

Latest hardware:
Ethernet based

• 32-bit, multi-thread processor
• 2-16MB of memory

• 156kBaud max speed

Hierarchical Servers ✔ ✔ ✔

Alarm-Pop Notification ✔ ✔

Email Action Sends 
Attachments ✔ ✔

Intelligent Alarm 
Filtering ✔ ✔

Auto-Pilot ✔ ✔

Maintenance Mode ✔ ✔

New Alarm Severity 
Levels ✔ ✔

Unit Bezel 
Enhancements ✔ ✔

Mini Status Bezels ✔ ✔

Administative Floor plan 
and Graphic Changes ✔ ✔

Energy Tracking 
Module ✔ ✔

Secure VPN Gateway ✔ ✔

Enhanced Status-at-a-
Glance Summary Views ✔

User-Configurable 
Bezel Color Schemes ✔

Enhanced Floor Plan 
Management ✔

Trellis Integration ✔
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6.0 GETTING STARTED WITH LIEBERT SITESCAN WEB

This section explains how to start the Liebert SiteScan Web application, log in and change your 
password. You should change the default password for security purposes. 

Saving Changes
You must save certain changes to Liebert SiteScan Web. Whenever you make a change that is not yet 
saved, the OK and Cancel buttons  appear at the top of the toolbar:

• Click on the OK button  to save your changes.
or

• Click on the Cancel button  to cancel your changes.

Using Internet Explorer

Liebert SiteScan Web is designed to work in Microsoft® Internet Explorer. If you use a different 
browser, screens appear in Wireless Access Protocol (WAP) formats.

6.1 Start Liebert SiteScan Web
To begin a session:

• Click on the Start button, then on Programs, then on Internet Explorer. 
• Type the address of the Liebert SiteScan Web server in the Address Bar and press the Enter key. 

6.2 Log on
After connecting to the server, the 
login screen appears, as shown at 
right.

To log on:

• Enter the user name in the 
Name box.

• In the Password box, enter the 
password provided by Liebert 
Services. To change the 
password, see 11.1.1 - Settings.

• Click the Log In button.
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7.0 VIEWING STATUS

The Graphics button offers a quick look of the status of your entire system or any portion of it.

7.1 View Graphic Status
To view a graphic representation of your system:

• Click the GEO button in the bottom left corner.
• Click on an item in the geographic tree at left—Data Center Power in the example below.
• Click the Graphics menu action button at the top. The example below shows a 3D floor plan.

• Each item in the floor plan has a clickable site icon with two parts:
• A text label with the user-assigned name 
• A color-coded button indicate whether active alarms are present (red) or not (white). For 

alarm details, see 8.0 - Managing Alarms.

• Hover over the color-coded button to display key information in a translucent popup box—the 
current status and the number of alarms, warnings and other information. This information is 
also available on a summary page for all components in the selected area (see 5.4.2 - Summary 
Bezel Shortcut).

• Click on any color-coded button to go to a view of that item. Color-coded buttons on the new view 
shows information for item components; hover text reveals the component’s status.

Color Indicates:

Red A critical alarm is present

White No alarms are present

Yellow A warning is present

Blue A message is present

Purple Loss of communication

Gray Maintenance Mode

GEO
button

Click on 
an item 
in tree

Graphics 
button

Label
Click to 
view item

Color-coded 
button
Hover to 
display status
Status shown 
in translucent 
graphic

Color-coded button
Hover to display status
Status shown in 
translucent graphic

Label
Click to 
view 
component 
data
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7.2 View Unit Data
• To view the status of a unit, click on the device in the tree at left to display detailed information, 

as in this example of a Liebert Precision Cooling unit.

• In the Alarms section at the bottom of the window, click on any tab to display descriptive text for 
alarms that have been detected:

• Critical - text description of critical alarms detected
• Warnings - text description of warnings detected
• Messages - text description of alarm messages sent

7.3 View an Area Graphic or Summary Pages

Two types of graphics are available in Liebert SiteScan Web:

• Area Graphic - a drawing showing device placement (purchased separately)
• Summary Pages - a text listing with status of all components of a selected item (standard). 

Available summary pages are:
• Unit_summary
• Air_summary
• Power_summary
• Ups_summary and
• Staticswitch_summary

DEVICE 
STATUS
AT A 
GLANCE

ALARMS tabs
Critical
Warnings 
Messages

Select device 
in tree
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7.3.1 View an Area Graphic
• Click the GEO button at bottom left, then click on an item in the tree at left.
• Click the Area Graphic shortcut or click the Graphics button.

7.3.2 View a Summary Page

Summary pages can viewed by these methods:

• Click the GEO button at the bottom left of the Web page, then click on an item in the tree.
• Click the appropriate shortcut on the Liebert SiteScan Web toolbar.

OR 
• Click the Graphics button drop-down arrow and choose the desired summary page.

Area Graphic 
shortcut

GEO
button

Click on 
an item 
to view

Graphics 
button

Graphics button drop-down

Summary Pages

Unit_summary
Air_summary

Power_summary
Ups_summary

Staticswitch_summary

Toolbar
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Unit Summary

The Unit Summary will present different views, depending on the level selected in the Geo tree.

The example below shows a summary of an installation’s top level of the Geo tree. It lists all the areas 
it includes with alarm information for each area.

An area’s Unit Summary may have multiple types of units. The Unit Summary page will list the 
monitored equipment in that area (cooling units, power equipment, UPS’s and static switches). 
Summary pages are also available for any sub areas.

Sub Area

Area

Included 
Sub Area

Equipment
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7.3.3 Unit-Specific Summary Pages

Liebert SiteScan Web displays summary pages for types of units. The Precision Cooling units will be 
grouped and shown on the Air Summary Page. Similarly, all Liebert units will be shown on their 
associated summary pages.

Summary Pages—Air, Power, UPS, Staticswitch

Air
Summary

Power
Summary

 UPS
Summary

 Static Switch
Summary
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8.0 MANAGING ALARMS

The Alarms button offers quick access to alarm-related features:

• View, acknowledge and delete alarms
• Set up actions that Liebert SiteScan Web performs when an alarm is received
• Customize alarms by changing the message
• Generate alarm reports to view, print or save to a file

8.1 Alarms Window Overview
• Click the GEO button in the bottom left corner.
• Click on an item in the tree at left—Emerson in the example below.
• Click the Alarms menu action button at the top. 
• The Alarms window has several tabs across the top; the example below shows the View tab.

• The alarm list displays all alarms for the location selected in the tree at left, including all items 
below it in the tree.

• For details on viewing alarms, see 8.2.1 - View the Alarm List.
• For instructions on responding to alarms, see 8.2.2 - Acknowledge and Delete Alarms.

GEO
button

Click on 
an item 
to view

System 
Level 
Alarms 
shortcut 
icon

Alarms button 
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8.2 View Alarms

The View tab allows you to view alarms and perform functions such as acknowledging alarms. 

To access the View functions:

• Click the GEO button, then click on an item in the tree at left.
• Click the Alarms button, then the View tab.

• Delete
• Additional Actions

Status table

Navigation
buttons

Alarm Action buttons (see Section 8.2.2)
• Acknowledge
• Force Normal

View 
tab

Alarm 
list

Alarm Categories list

View By
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8.2.1 View the Alarm List
• Double-click on an alarm in the list to reveal or hide more details about the alarm. The alarm list 

displays three columns of information about each alarm:

• Use the navigation buttons at right to scroll through the list one alarm at a time, a page at a time 
or to the beginning or end of the list.

• To view all types of alarms or choose from the Alarm Categories list:
• To display all alarms, click to place a check mark (✔) in the Select All box. 
• To display only selected alarms, click on an item in the Alarm Categories list. 

(Control-click to select additional items.)
• To sort or filter the list, click on the down arrow to the right of the View By box, then select an 

option from the drop-down menu:

• The status table to the right of the View By box offers a quick glance at the current state of alarms 
at the location selected in the tree (Here) and in the entire system (Total):

8.2.2 Acknowledge and Delete Alarms
To access the alarm action functions:

• Click the GEO button, then click on an item in the tree at left.
• Click the Alarms button, then the View tab.

Acknowledge a Single Alarm
• Select an alarm that shows Acknowledge in the To Do column.
• Click the Acknowledge button below the list. A check mark (✔) appears in the To Do column.

Force a Return-To-Normal State
If an alarm is not followed by a return-to-normal event, you can force a Return-To-Normal state:

• Select an alarm that shows Waiting for normal in the To Do column.
• Click the Force Normal button below the list. A check mark (✔) appears in the To Do column.

• Occurred The date and time the alarm was generated.

• To Do • Acknowledge indicates the alarm needs to be acknowledged. 
• Waiting for Normal indicates the alarm requires a return-to-normal. 
• A check mark (✔) indicates the alarm is closed.

• Alarm
Report 

Displays the alarm message—a text description of what occurred and where.

• Date Displays all alarms sorted by the time each alarm was generated, from newest to oldest.

• To Do Displays only alarms requiring one or more actions to be done before they can be closed.

• Incident
Group 

Groups all alarms related to a particular incident with a bracket to the left of the icons—
for example, an alarm and its subsequent return-to-normal event form an incident group.

• Need Rtn Number of alarms that need a return-to-normal

• Need Ack Number of alarms that need to be acknowledged

• Closed Number of alarms that are closed

DeleteAcknowledge Additional ActionsForce Normal

Alarm 
list

View 
tab



Managing Alarms

Liebert® SiteScan Web™ 27

Delete a Single Alarm
• Select the alarm you want to delete from the list.
• Click the Delete button below the list. The alarm disappears from the list.

Additional Actions: Acknowledge/Delete Multiple Alarms, Search for an Alarm
The Additional Actions button allows you to acknowledge or delete multiple alarms all at once.

• Unless you want to acknowledge or delete all alarms, select the appropriate alarms—for example, 
click on View By To Do, then highlight alarms that show Acknowledge in the To Do column.

• Click the Additional Actions button below the list. The 
Additional Alarm Actions window opens, as shown at right.

Acknowledge Multiple Alarms
• To acknowledge multiple alarms, click the All button 

under Acknowledge Alarms in Selected Categories.

Delete Multiple Alarms
• To delete multiple alarms, click the appropriate button 

under Delete Alarms in Selected Categories:

Search for an Alarm by Time of Occurrence
• In this window, you may also search for an alarm generated on a particular date and time. 

Enter the desired date and time, then click the Search button. The Events screen will display 
the listing of alarm events as defined by the search criteria.

• Closed 
Incidents

Removes incident groups of related alarms 
in which all alarms have been closed.

• All Removes all alarms at the selected location 
in the tree.

Acknowledge selected alarms

Delete

Search
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8.3 Messages

An alarm message is the text displayed in the Alarms View tab window and in alarm reports. An 
alarm message may consist of three parts: 

This section describes how to add, change or delete the Prefix and Details portions of alarm messages. 

Changes apply to the location in the tree where they are added and to all its subordinate members of 
the tree. For example, if you add Details at the system level to show the Acknowledge Time for alarms 
in a certain category, that will appear in all alarm message for any element in the system.

To access the Message functions:

• Click the GEO button, then click on an item in the tree at left.
• Click the Alarms button, then the Messages tab. Steps are listed in red, as shown below.

1. Select the categories that contain the alarm sources with messages you want to edit.
2. Select the alarm sources for the selected categories.

Note: In Steps 1 and 2, control-click to select multiple items, or check the Select All box.
3. Click on the down arrow and select an option from the drop-down menu: Add new prefix to 

beginning of message or Add new details to end of message.

4. Click the Add button to open the appropriate window. The Message Details window, shown 
above right, allows you to make separate entries for alarms and return-to-normal events.

• Type the text you want to add to the message in the text boxes.
• To add a field code to a message, click the Append Field Code down arrow and select an option 

from the drop-down menu (see Table 5 for definitions). 
• Click the OK button to save your changes (or click Cancel to close without saving).

5. The new Prefix or Details appears in the Messages tab window. Click the Edit button to 
make additional changes. Click Delete to remove the item.

Prefix (optional) Text Details (optional)

Text at beginning of message The alarm or return-to-normal Text at end of message

Messages 
tab

Step 1

Step 2

Step 3

Text 
boxes

Field 
codes

MESSAGE PREFIX MESSAGE DETAILS (END)
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8.4 Actions

Certain Liebert SiteScan Web features may be set up to protect valuable equipment, data and other 
assets by responding automatically to alarms in devices affected by such events as power failures, 
overheating and mechanical failures.

For example, if a cooling unit’s performance becomes impaired, Liebert SiteScan Web may be set up to 
send e-mail alerts to various personnel, record data pertaining to the event and append it to a 
particular file and launch a command or batch file that can execute user-customized scripts.

• Click the GEO button, then click on an item in the tree at left.
• Click the Alarms button, then the Actions tab. Steps are listed in red, as shown below.

1. Select the categories that contain the alarm sources to be set up.
2. Select the alarm sources for the selected categories.

Note: In Steps 1 and 2, control-click to select multiple items, or check the Select All box.
3. To choose an action, click on the down arrow and select an option from the drop-down menu. 
4. Click the Add button.
5. Proceed to the appropriate section to continue setting up the action.

• 8.4.1 - Alarm Popup Action
• 8.4.2 - Print Action
• 8.4.3 - Run External Program Action
• 8.4.4 - Send Alphanumeric Page Action
• 8.4.5 - Send E-Mail Action
• 8.4.6 - Send SNMP Trap Action
• 8.4.7 - Write Property Action
• 8.4.8 - Write to Database Action
• 8.4.9 - Write to File Action

Actions 
tab

Step 1

Step 2

Step 3

Configured 
actions
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8.4.1 Alarm Popup Action

The Alarm Popup action sends an alert to designated recipients’ computers when specified alarms 
occur. The alert pops up in a dialog box on each recipient’s computer when an alarm occurs. 

A recipient may be any networked computer running the Liebert SiteScan Web Alarm Popup 
application. Individuals and groups may be selected from a list set up via the CFG functions. For 
details on editing these lists, see 11.3.1 - Set Up Operators and 11.3.2 - Create Operator Groups.

Open the Alarm Popup window, shown below, to set up this action. To do this:

• Click the GEO button, then click on an item in the tree at left. When configured, the action will 
apply to the designated item in the tree as well as its subordinate items.

• Click the Alarms button, then the Actions tab. Perform Steps 1-3 (see 8.4 - Actions):
• Select the alarm categories (Step 1) and alarm sources (Step 2) you want linked this action.
• Select Alarm Popup from the drop-down menu (Step 3), then click Add.

• Specify the recipients who should receive notifications by clicking on the appropriate down arrow 
and selecting a name from the drop-down list:

• Select an individual from the To Operator list, then click the Add button.
• Select a group of operators from the To Group list, then click the Add button.

• Once added, the selected names appear in the Recipients list with a check box in the Generate 
Alarm if Delivery Fails column. Click to place a check mark (✔) to send a System Info alarm to 
the Liebert SiteScan Web server if the recipient is not running the Alarm Popup application when 
an alert is sent.

• In the Message Text box, enter the message as you want it to appear in the popup window, using 
the appropriate punctuation, including spaces and returns to separate lines of text.

• You can add dynamic alarm data to the text by selecting field codes from the Append Field Code 
list (see Table 5 for definitions). To do this:

• Place the cursor in the Message Text box where you want the data to appear.
• Click on the Append Field Code down arrow, then select an option from the drop-down list.

• By default, the action will be performed both when an alarm is detected and after the device 
returns to normal. In the Perform Action section, you may specify when to run the action:

• Only when the device is In Alarm or after Return to Normal.
• After a specified time if not Returned to Normal or not Acknowledged.*
• If a group with a specified schedule is Occupied (e.g., during work hours) or Unoccupied.*

* Available only with Advanced Alarming
• When finished, click the OK button (or Cancel to close the window without saving your changes).

Once the action is set up, it appears in the Actions tab window. To remove it, click the Delete 
button; to make changes, click the Edit button.

Message text

Field codes

OK / Cancel

Recipients

Perform 
action
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8.4.2 Print Action

The Print action sends an alert to a designated printer when a specified alarm occurs. The printed 
message may be sent to any printer connected to the server or a workstation on the network.

Open the Print window, shown below, to set up this action. To do this:

• Click the GEO button, then click on an item in the tree at left. When configured, the action will 
apply to the designated item in the tree as well as to its subordinate items.

• Click the Alarms button, then the Actions tab. Perform Steps 1-3 (see 8.4 - Actions):
• Select the alarm categories (Step 1) and alarm sources (Step 2) you want linked this action.
• Select Print from the drop-down menu (Step 3), then click Add.

• Click to place a check mark (✔) to choose a printing method based on the printer type:
• Select Text Printing when using a dot matrix printer; this prints multiple alarms per page.

Enter the designated name of the printer in the Printer Name box—for example, LPT1. 
Enter the maximum line width in the Line Width box.

• Select Graphics Printing when using a laser printer; this prints one alarm per page.
Click on the Font Name arrow and select the font: Arial, Courier, Sans Serif or Times New 
Roman.
Click on the Font Style arrow and select a style: Plain, Bold or Italics. 
Enter the point size in the Font Size box—for example, 10 for 10-point type.

• In the Text to Print box, enter the message as you want it to appear, using the appropriate 
punctuation, including spaces and returns to separate lines of text.

• You can add dynamic alarm data to the text by selecting field codes from the Append Field Code 
list (see Table 5 for definitions). To do this:

• Place the cursor in the Text to Print box where you want the data to appear.
• Click on the Append Field Code down arrow, then select an option from the drop-down list.

• By default, the action will be performed both when an alarm is detected and after the device 
returns to normal. In the Perform Action section, you may specify when to run the action:

• Only when the device is In Alarm or after Return to Normal.
• After a specified time if not Returned to Normal or not Acknowledged.*
• If a group with a specified schedule is Occupied (e.g., during work hours) or Unoccupied.*

* Available only with Advanced Alarming
• When finished, click the OK button (or Cancel to close the window without saving your changes).

Once the action is set up, it appears in the Actions tab window. You may click the Edit button to 
make changes or the Delete button to remove it.

Text
options

Graphics
options

Message 
text

Field 
codes

OK / Cancel

Perform 
action
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8.4.3 Run External Program Action

The Run External Program alarm action launches a script that starts a program or batch file on the 
server when an alarm is received.

Open the External Program window, shown below, to set up this action. To do this:

• Click the GEO button, then click on an item in the tree at left. When configured, the action will 
apply to the designated item in the tree as well as its subordinate items.

• Click the Alarms button, then the Actions tab. Perform Steps 1-3 (see 8.4 - Actions):
• Select the alarm categories (Step 1) and alarm sources (Step 2) you want linked this action.
• Select Run External Program from the drop-down menu (Step 3), then click Add.

• Enter the path of the executable file to be run followed by the path of the output file. For example:
c:\windows\notepad.exe
c:\SiteScan Web\output1.txt
In the example, the program Notepad will be opened and a text file named output1.txt will 
be created in the SiteScan Web program folder on the server’s C: drive

• Append Field Codes to the command line by choosing from the drop down list (see Table 5 for 
definitions). More than one field code may be chosen. For example:

c:\reports\run_report.bat $Generation_time$$To_State$
This starts a batch file on the server and uses the alarm's generation time and state as values.

• Placing a check mark (✔) in the Synchronize box forces a delay until the external program has 
finished running before initiating the next Run External Program alarm action.

• By default, the action will be performed both when an alarm is detected and after the device 
returns to normal. In the Perform Action section, you may specify when to run the action:

• Only when the device is In Alarm or after Return to Normal.
• After a specified time if not Returned to Normal or not Acknowledged.*
• If a group with a specified schedule is Occupied (e.g., during work hours) or Unoccupied.*

* Available only with Advanced Alarming
• When finished, click the OK button (or Cancel to close the window without saving your changes).

Once the action is set up, it appears in the Actions tab window. You may click the Edit button to 
make changes or the Delete button to remove it.

Command line
Field codes

OK / Cancel

Perform 
action
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8.4.4 Send Alphanumeric Page Action

The Send Alphanumeric Page alarm action sends a page to one or more alphanumeric pagers or sends 
text messages to cell phones. The recipient’s pager or phone must be able to accept e-mail.

Do not assign the Alphanumeric Page alarm action to frequently occurring alarms if you are using a 
stand-alone workstation. Sending pages for a frequently occurring alarm may dramatically slow down 
your system and cause problems with your mail server.

If the page will be sent over the Internet from a workstation that is not directly connected to the 
Internet, the workstation must first be configured to connect to the Internet automatically (see Set 
Up a Dial-Up Networking Connection on page 34).

Open the Alphanumeric Page window, shown below, to set up this action. To do this:

• Click the GEO button, then click on an item in the tree at left. When configured, the action will 
apply to the designated item in the tree as well as its subordinate items.

• Click the Alarms button, then the Actions tab. Perform Steps 1-3 (see 8.4 - Actions):
• Select the alarm categories (Step 1) and alarm sources (Step 2) you want linked this action.
• Select Send Alphanumeric Page from the drop-down menu (Step 3), then click Add.

• In the To box, enter the service provider’s phone number in this format: 1 800-555-1212. Do not 
use parentheses around the area code. More than one recipient may be specified.

• Enter a valid address, if required by your mail server, in the From box.
• Enter a subject of the notification in the Subject box.
• Enter your Simple Main Transfer Protocol in the Mail Host box. This can be either an IP address 

or a system name, such as mail.mycompany.com.
• If your mail server requires a user name and password, put a check mark (✔) in the Specify Mail 

User box. This opens the Mail User and Password boxes to accept the information.
• Put a check mark (✔) in the Send mail as MIME attachment box if your mail server allows 

only MIME attachments.
• Compose a message to be sent in the Message Text box, using punctuation, spaces and returns 

to format the text.
• Add live data to the message by selecting field codes from the Append Field Code list (see 

Table 5 for definitions).
• By default, the action will be performed both when an alarm is detected and after the device 

returns to normal. In the Perform Action section, you may specify when to run the action:
• Only when the device is In Alarm or after Return to Normal.
• After a specified time if not Returned to Normal or not Acknowledged.*
• If a group with a specified schedule is Occupied (e.g., during work hours) or Unoccupied.*

* Available only with Advanced Alarming
• When finished, click the OK button (or Cancel to close the window without saving your changes).

Once the action is set up, it appears in the Actions tab window. You may click the Edit button to 
make changes or the Delete button to remove it.

Message text

Field codes

OK / Cancel

Message 
Authentication 
Data

Perform 
action



Managing Alarms

34 Liebert® SiteScan Web™

Set Up a Dial-Up Networking Connection

A dial-up networking connection must be set up if the page will be sent over the Internet from a 
workstation that is not directly connected to the Internet. This enables SiteScan Web to dial out to 
send an e-mail or alphanumeric page. After creating and executing an alarm action, the modem 
should dial automatically, then hang up after a minute of inactivity.

• Set up your server and modem to dial the default connection to your Internet Service Provider. 
See your server and modem documentation.

• Connect to the Internet and enter your Internet Service Provider's name and phone number, then 
your user name and password. Your modem must be detected before you can configure your 
Internet account connection.

• Type the following line at the end of the system.properties file in your system directory:
repactions.connection.name=<name of connection>

8.4.5 Send E-Mail Action

Use the Send E-Mail action to send customized e-mail messages to selected recipients when an alarm 
occurs.

Do not assign the Send E-Mail alarm action to frequently occurring alarms if you are using a stand-
alone workstation. Sending e-mails for a frequently occurring alarm may dramatically slow down 
your system and cause problems with your mail server.

If the e-mail will be sent from a workstation that is not directly connected to the Internet, the 
workstation must first be configured to connect to the Internet automatically (see Set Up a Dial-Up 
Networking Connection on page 34).

Open the Email window, shown below, to set up this action. To do this:

• Click the GEO button, then click on an item in the tree at left. When configured, the action will 
apply to the designated item in the tree as well as its subordinate items.

• Click the Alarms button, then the Actions tab. Perform Steps 1-3 (see 8.4 - Actions):
• Select the alarm categories (Step 1) and alarm sources (Step 2) you want linked this action.
• Select Send E-Mail from the drop-down menu (Step 3), then click Add.

• In the To box, enter the recipient’s e-mail address. More than one recipient may be specified.
• Enter a valid address, if required by your mail server, in the From box.
• Enter a subject for the e-mail notification in the Subject box.
• Enter your Simple Main Transfer Protocol in the Mail Host box. This can be either an IP address 

or a system name, such as mail.mycompany.com.
• If your mail server requires a user name and password, put a check mark (✔) in the Specify Mail 

User box. This opens the Mail User and Password boxes to accept the information.

Message text

Field codes

OK / Cancel

Message 
Authentication 
Data

Perform 
action
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• Put a check mark (✔) in the Send mail as MIME attachment box if your mail server allows 
only MIME attachments.

• Compose a message to be sent in the Message Text box, using punctuation, spaces and returns 
to format the text.

• Add live data to the message by selecting field codes from the Append Field Code list (see 
Table 5 for definitions).

• By default, the action will be performed both when an alarm is detected and after the device 
returns to normal. In the Perform Action section, you may specify when to run the action:

• Only when the device is In Alarm or after Return to Normal.
• After a specified time if not Returned to Normal or not Acknowledged.*
• If a group with a specified schedule is Occupied (e.g., during work hours) or Unoccupied.*

* Available only with Advanced Alarming
• When finished, click the OK button (or Cancel to close the window without saving your changes).

8.4.6 Send SNMP Trap Action
The Send SNMP Trap alarm action sends an SNMP trap in response to receiving an alarm. Traps 
contain the text created in the Text to send as the SNMP Trap field in the alarm action dialog box. 
You can configure up to five SNMP servers to receive traps.

Liebert SiteScan Web supports SNMP v1.

Each SNMP server chosen to receive these traps must have SNMP monitoring equipment installed. If 
problems arise with your SNMP connection or receiving traps, contact your information services 
department.

To set up this action, open the SNMP window, shown below. To do this:

• Click the GEO button, then click on an item in the tree at left. When configured, the action will 
apply to the designated item in the tree as well as its subordinate items.

• Click the Alarms button, then the Actions tab. Perform Steps 1-3 (see 8.4 - Actions):
• Select the alarm categories (Step 1) and alarm sources (Step 2) you want linked this action.
• Select Send SNMP Trap from the drop-down menu (Step 3), then click Add.

• Put a check mark (✔) in the Enable box and enter the SNMP server’s network address 
community name in the appropriate boxes. Obtain this information from your network 
administrator.
Deleting the check mark (✔) from an Enable box removes the attendant address from the SNMP 
trap notification.
The Comment (optional) field may be used for the location of the SNMP server.

• Trap number box accepts a numeral from 1 to 127 to identify a message from this alarm action. 
This featured is used if trap numbers have been configured. Obtain this information from your 
network administrator. The same trap number is used for all messages from this alarm action.

Message text

Field codes

OK / Cancel

Perform 
action
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• The Text to send as the SNMP Trap box will accept up to 255 characters. Longer messages will 
be truncated.
Use punctuation, spaces and returns to format the message. You may customize the message by 
selecting field codes from the Append Field Code list (see Table 5 for definitions).

• By default, the action will be performed both when an alarm is detected and after the device 
returns to normal. In the Perform Action section, you may specify when to run the action:

• Only when the device is In Alarm or after Return to Normal.
• After a specified time if not Returned to Normal or not Acknowledged.*
• If a group with a specified schedule is Occupied (e.g., during work hours) or Unoccupied.*

* Available only with Advanced Alarming
• When finished, click the OK button (or Cancel to close the window without saving your changes).

8.4.7 Write Property Action

The Write Property alarm action updates a microblock property value.

Open the Write Property window, shown below, to set up this action. To do this:

• Click the GEO button, then click on an item in the tree at left. When configured, the action will 
apply to the designated item in the tree as well as its subordinate items.

• Click the Alarms button, then the Actions tab. Perform Steps 1-3 (see 8.4 - Actions):
• Select the alarm categories (Step 1) and alarm sources (Step 2) you want linked this action.
• Select Write Property from the drop-down menu (Step 3), then click Add.

• In the Expression box, enter the microblock value that you want to update.
• In the Value to Write box, type the value you want to write to the microblock property. For a 

binary property, type 0 or 1.
• Select field codes from the drop-down list to add to the Value to Write field.
• By default, the action will be performed both when an alarm is detected and after the device 

returns to normal. In the Perform Action section, you may specify when to run the action:
• Only when the device is In Alarm or after Return to Normal.
• After a specified time if not Returned to Normal or not Acknowledged.*
• If a group with a specified schedule is Occupied (e.g., during work hours) or Unoccupied.*

* Available only with Advanced Alarming
• When finished, click the OK button (or Cancel to close the window without saving your changes).

Value to be written

Field codes

OK / Cancel

Perform 
action

Expression



Managing Alarms

Liebert® SiteScan Web™ 37

8.4.8 Write to Database Action

The Write to Database alarm action stores alarm information in a table in the Liebert SiteScan Web 
alarm database or in a custom database. Third-party applications can access the alarm information 
for building maintenance management or alarm analysis. For example, an application can perform 
such actions as triggering a stored procedure or running a report.

Open the Database Write window, shown below, to set up this action. To do this:

• Click the GEO button, then click on an item in the tree at left. When configured, the action will 
apply to the designated item in the tree as well as its subordinate items.

• Click the Alarms button, then the Actions tab. Perform Steps 1-3 (see 8.4 - Actions):
• Select the alarm categories (Step 1) and alarm sources (Step 2) you want linked this action.
• Select Write to Database from the drop-down menu (Step 3), then click Add.

Writing to the Liebert SiteScan Web Alarm Database

When you add the Write to Database alarm action, by default Liebert SiteScan Web writes alarm 
information to the write_db_ra table in the alarm database. The following table describes the 
information that SiteScan Web writes to the database and gives the column name and data type you 
will need in order to access the alarm information from a third-party application.

To keep the database table from growing too large, you must delete old entries using a third-party 
database application. You cannot view, edit or delete entries from SiteScan Web.

Description Column Name Data type

Alarm generation time EVENT_TIME_ Datestamp

Reference name path to the alarm source
Example: #slm/m073 SOURCE_PATH_ String

Display name path to the alarm source
Example: Atlanta Office/R&D Facility/Second Floor/VAV 2-1/Zone Temp DISPLAY_NAME_ String

Alarm state
Example: OFF NORMAL, LOW LIMIT, HIGH LIMIT

EVENT_STATE_ String

Alarm text as defined in the Text to write to the database field on the 
alarm action page. You can add live data to the text by selecting field 
codes from the Append Field Code list (see Table 5 for definitions). 

RA_TEXT_ String 

NOTE
If your system uses an Access or MSDE database, you cannot open the database in a 
third-party application while Liebert SiteScan Web or SiteBuilder is running.

Message text

Field codes

OK / Cancel

Perform 
action



Managing Alarms

38 Liebert® SiteScan Web™

Writing to a Custom Database

Liebert SiteScan Web can write alarm information to the following types of custom databases. The 
custom database does not have to be the same type as the Liebert SiteScan Web database.

• SQL Server 
• MySQL 
• PostgreSQL 
• Oracle

You may create a table in an existing, third-party database or create a new database.

Using your database management tool, create a table in your custom database that includes fields for 
each alarm field code to be written to the table. Each field length in the table should be as long as the 
longest value to be written to that field.

To set up Liebert SiteScan Web to write to a custom database instead of to the Liebert SiteScan Web 
alarm database, select the Specify Custom Database check box on the Alarms page Actions tab, 
shown below. This reveals fields specifying how Liebert SiteScan Web writes to the database.

To enter the required information, refer to the following table.

Field Notes

Text to write
to the
database

The text is made up of field codes that add live data to the text. You can select additional field 
codes from the Append Field Code list (see Table 5 for definitions).
NOTE: To write the text in this field to the custom database, you must include the Report Text 
field code ($report_text$) in the Database Insert String field described below. 

Database
Connect
String

For database
type:
SQL Server
MySQL
PostgreSQL
Oracle

The connect string format is...
jdbc:odbc:<odbc_alias>
jdbc:mysql://<host>:<port>/<instance>
jdbc:postgresql://<host>:<port>/<instance>
jdbc:oracle:thin@<host>:<port>/<instance>

where:
<host> is the database server name/IP address
<port> is the port number for the database
<instance> is the database name in the database server
<odbc_alias> is the name of the ODBC data source

Database Login
and Password The login and password to connect to the database.

Database
Insert
String

Use the following format:
Insert into <TABLE_NAME> (<column1_name>, <column2_name> ...) values 
(<$field_code1$>, <$field_code2$>, ...)
Example:
Insert into SiteScan Web_ALARMS (TIME_, LOCATION_, TO_STATE_, TEXT_) values 
($generation_time$, $location_path$, $to_state$, $report_text$)
NOTE: You can add field codes to the Insert String using the Append Field Code list. 
If you add a timestamp type field code (for example, $generation_time$), you should have the 
data go into a timestamp data type field in the custom database. Otherwise, you must use field 
code formatting to format the time.

Specify Custom 
Database box
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8.4.9 Write to File Action

The Write to File action allows you to record alarm information in a file.

Open the File Write window, shown below, to set up this action. To do this:

• Click the GEO button, then click on an item in the tree at left. When configured, the action will 
apply to the designated item in the tree as well as its subordinate items.

• Click the Alarms button, then the Actions tab. Perform Steps 1-3 (see 8.4 - Actions):
• Select the alarm categories (Step 1) and alarm sources (Step 2) you want linked this action.
• Select Write to File from the drop-down menu (Step 3), then click Add.

• Enter a name in the File Name box.
• Choose either Write to File or Write as Report.
• Click to place a check mark (✔) in the Append box to add new entries at the end of the file.

Note: If you do not check the Append box, the file contents will be overwritten with each new 
alarm message.

• In the Text to Write to the File box, enter the message as you want it to appear, using the 
appropriate punctuation, including spaces and returns to separate lines of text.

• You can add dynamic alarm data to the text by selecting field codes from the Append Field Code 
list (see Table 5 for definitions). To do this:

• Place the cursor in the Text to Write to the File box where you want the data to appear.
• Click on the Append Field Code down arrow, then select an option from the drop-down list.

• By default, the action will be performed both when an alarm is detected and after the device 
returns to normal. In the Perform Action section, you may specify when to run the action:

• Only when the device is In Alarm or after Return to Normal.
• After a specified time if not Returned to Normal or not Acknowledged.*
• If a group with a specified schedule is Occupied (e.g., during work hours) or Unoccupied.*

* Available only with Advanced Alarming
• When finished, click the OK button (or Cancel to close the window without saving your changes).

Once the action is set up, it appears in the Actions tab window. You may click the Edit button to 
make changes or the Delete button to remove it.

Message text

Field codes
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8.4.10 Field Code Definitions

Table 5 shows the field codes displayed in Action and Messages windows.

Table 5 Field code definitions

Field Code Name Field Code Definition

Acknowledge Operator $acknowledge_operator$ The operator who acknowledged the alarm.

Acknowledge Time $acknowledge_time$ The time when the operator acknowledged the alarm.

Alarm Category $event_category$ The alarm category that the alarm is assigned to.

Alarm Template $event_template$ The alarm template that the alarm is assigned to.

Alarm Type $event_type$ The alarm type of the alarm source; for example, CHANGE OF 
VALUE, CHANGE OF STATE.

Alarm Value $alarm_value$ The alarm value.

Alert Text $alerttext$

For a converted SuperVision system if the option Create a single 
alarm template... was selected during upgrade. Retrieves alarm 
message text from cmnet_alert_text.properties.

To use this field code:

1. Select the Alert Text field code.

2. After $alerttext, type one of the following:

:normalshort

:normallong

:alarmshort

:alarmlong

For example, $alerttext:alarmlong$

Character $c$
A single ASCII character. Often used for form feeds and other 
printer escape sequences.
For example, $C:65$ displays A.

Command Value $command_value$ 
The commanded value from the alarm source. Valid only for alarm 
type COMMAND FAILURE. 

Dead Band $deadband$ The deadband value from the alarm source. Valid only for alarm 
type OUT-OF-RANGE. 

Deletion Operator $deletion_operator$ The operator who deleted the alarm.

Deletion Time $deletion_time$ The time the alarm was deleted.

Device $device$ The display name of the device where the alarm came from.

Equipment $equipment$ The display name of the equipment where the alarm came from.

Error Limit $error_limit$ The error limit, from the alarm source. Valid only for alarm type 
FLOATING LIMIT.

Exceeded Limit $exceed_limit$ 
The exceeded limit value from the alarm source. Valid only for 
alarm type OUT-OF-RANGE. 

Exceeding Value $exceeding_value$ The exceeding value from the alarm source. Valid only for alarm 
type OUT-OF-RANGE. 

Fault $fault$ The status of the fault condition from the alarm source. 

Feedback Value $feedback_value$ The feedback value from the alarm source. Valid only for alarm 
type COMMAND FAILURE. 

Field Message $field_message$ Additional text recorded in the alarm by the device. 

From State $from_state$ The previous state of the alarm source. 

Generation Operator $generation_operator$ The operator who forced the alarm to return to normal. 

Generation Time $generation_time$ The time in the module when the alarm was generated. 

In Alarm $in_alarm$ The in alarm status from the alarm source. 

Incident Closed Time $incident_closed_time$ The time the alarm's entire incident group closed.
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Latched Data Value (Analog) $latched_data_analog:x$ “x” ranges from 1 to 5.
The display name of the alarm source that generated the alarm.

Latched Data Value (Digital) $latched_data_digital:x$ “x” ranges from 1 to 5.
The display name of the alarm source that generated the alarm. 

Location Path $location_path$ Displays all the path display names from root to source.

Long Message $long_message$ The formatted alarm long text displayed by double-clicking the 
alarm on the Alarms page. 

Message Details $message_details$ The message details displayed on the Alarms page View tab.

Message Prefix $message_prefix$ The message prefix displayed on the Alarms page View tab.

Message Text $message_text$ The message text displayed on the Alarms page View tab.

New State $new_state$ The status of new state from the alarm source. 

New Value $new_value$
The new value from the alarm source. Valid only for alarm type 
CHANGE OF VALUE. 

Object ID $object_ID$ Object ID of the alarm source. 

Out of Service $out_of_service$ The status of 'out of service' from the alarm source. 

Overridden $overridden$ The status of 'overridden' from the alarm source. 

Program ID $program_id$ 

The address of the control program that generated the alarm.
BACnet program address format:
device ID, program number (example: 240219,5)
SuperVision program address format:
site, gateway, module, fb (example: 1, 2, 13, 5)

Receive Time $receive_time$ The time at the workstation when the alarm was received. 

Recipient Device ID $device_id$ The device ID of the device where the alarm came from.

Record Type $record_type$ The type of alarm; for example, BACnet, SuperVision, System. 

Reference Path $reference_path$ Path to alarm source. Available in all alarm actions.

Reference Value $reference_value$ The 'reference value' from the alarm source. Valid only for alarm 
type FLOATING LIMIT. 

Referenced Bitstring $referenced_bitstring$ 
The value of the 'referenced bitstring' value from the alarm source. 
Valid only for alarm type CHANGE OF BITSTRING. 

Report Text $report_text$ Used only with the Write to Database alarm action. You must 
include this field code in the Database Insert String.

RTN Time $RTN_time$ The time when the alarm returned to normal. 

Setpoint Value $setpoint_value$ The 'setpoint value' from the alarm source. Valid only for alarm 
type FLOATING LIMIT. 

Short Message $short_message$ The formatted alarm short text. 

Site $site$ The display name of the site the alarm came from. 

Source $source$ The display name of the alarm source that generated the alarm. 

Source description $source:description$ The description of the alarm source that generated the alarm.

Source Path $source:<path>$ 

For advanced users, displays the database item indicated by 
<path> relative to the alarm source; for example, <path> = 
~equipment.display-name. The easiest way to display the path is 
to use Global Modify. 

System Directory $system_dir$ The system folder name. 

To State $to_state$ The current state of the alarm source; for example, Normal, Fault, 
Off-normal, High limit, Low limit.

Table 5 Field code definitions

Field Code Name Field Code Definition
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8.5 Enable/Disable

The Enable/Disable tab in the Alarms window allows you to customize the treatment of alarms and 
return-to-normal events for selected alarm sources. Through this function, you may:

• Activate or deactivate alarms and return-to-normal events
• Classify alarms as critical or non-critical
• Specify whether an operator must acknowledge alarms and return-to-normal events

8.5.1 Enable or Disable Features

To access the Enable/Disable functions:

• Click the GEO button, then click on an item in the tree at left.
• Click the Alarms button, then the Enable/Disable tab. Steps are listed in red, as shown below.

1. Select the categories that contain the alarm sources you want to set up.
2. Select the alarm sources for the selected categories.

Note: In Steps 1 and 2, control-click to select multiple items, or check the Select All box.
3. To change settings for the selected alarm sources, click on the All or None radio button for 

each of the following features:

• When finished, click the OK button (or Cancel to close the window without saving your changes).

Feature If you click All to enable this feature, Liebert SiteScan Web:

• Alarm enabled Generates an alarm when specified conditions occur in the alarm source.

• Return enabled Generates a return-to-normal when the alarm source returns to a normal state.

• Classified as 
critical *

Changes the system-wide alarm button to red when an alarm occurs.
Critical alarms that pass through a modem are delivered to the Liebert 
SiteScan Web server immediately.

• Alarm requires
acknowledgement 

Requires that an operator acknowledge the alarm.

• Return requires
acknowledgement Requires that an operator acknowledge the return-to-normal event.

* Note: If the Classified as critical feature is disabled (None button selected), Liebert SiteScan Web 
changes the system-wide alarm button to yellow when an alarm occurs. Non-critical alarms that 
pass through a modem are stored in the gateway until one of the following happens:
• A critical alarm occurs.
• The gateway is contacted by Liebert SiteScan Web.
• The gateway buffer is full, at which time all alarms are sent to Liebert SiteScan Web.

Enable/Disable 
tab

Step 1

Step 2

Step 3

FeaturesView Selected 
Sources
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8.5.2 View Selected Sources

In the Enable/Disable tab, you may use the View Selected Sources button to view a listing of all 
selected alarm sources in a dialog box where you may enable or disable features for any source.

To access the Enable/Disable functions:

• Click the GEO button, then click on an item in the tree at left.
• Click the Alarms button, then the Enable/Disable tab. Steps are listed in red, as shown below.

• In the Enable/Disable tab window:
1. Select the categories that contain the alarm sources you want to view.
2. Select the alarm sources for the selected categories.

Note: In Steps 1 and 2, control-click to select multiple items, or check the Select All box.
3. Click the View Selected Sources button.

• A dialog box appears, listing all selected alarm sources with check boxes for enabled features, as 
shown below left. Use the scroll bar as needed to view additional sources.

• To enable a feature, click to place a check mark (✔) in the box. To disable a feature, click to 
remove the check mark.

• When finished, click OK (or Cancel to close the window without saving your changes).
• You may click on an alarm source to open a details window, below right. The name of the alarm 

source appears to the right of the tabs. Click the Close button to return to the previous view.

Enable/Disable 
tab
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8.6 Category

The Category tab in the Alarms window allows you to customize alarm categories, which are groups 
of related alarm sources and their alarms.

Alarm categories let you perform tasks on groups of alarms, for example:

• View, acknowledge, or delete selected categories of alarms
• Assign alarm actions to selected categories of alarm sources
• Set up alarm sources in selected categories

Each alarm source is assigned to an alarm category, but you can change the category assignment in 
this window.

Liebert SiteScan Web has default alarm categories, but you can also create custom categories, if 
needed. (To do this, click the CFG button, open the Categories folder in the tree and click on Alarm. 
See the online help for more information.)

To access the Category functions:

• Click the GEO button, then click on an item in the tree at left.
• Click the Alarms button, then the Category tab. Steps are listed in red, as shown below.

1. Select the categories that contain the alarm sources you want to customize.
2. Select the alarm sources for the selected categories.

Note: In Steps 1 and 2, control-click to select multiple items, or check the Select All box.
3. To assign a different category for the selected alarm sources:

• Click on the drop-down menu and choose a category from the list. 
• Click the Change button.

• Click the View Selected Sources button to open a window showing the selected items, above 
right. Each source has a link to a details window and shows the category currently assigned.

• When finished, click the OK button (or Cancel to close the window without saving your changes).

Category
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8.7 Template

All alarms in Liebert SiteScan Web v2.5 and later use one template called Universal. This template 
lets you define your alarm message text, the critical setting and the required acknowledgements at 
the alarm source.

If you upgraded your system from v2.0 or earlier, the alarm sources retained their existing templates 
and existing alarm settings. If the existing alarm sources contain little or no customization to the 
alarm settings, Emerson recommends that you change all of the alarms to use the Universal 
template. If the alarm sources had customized alarm settings, continue using the existing templates.

To assign a different template to alarm sources:

• Click the GEO button, then click on an item in the tree at left.
• Click the Alarms button, then the Template tab. Steps are listed in red, as shown below.

1. Select the categories that contain the alarm sources for which you want to change the 
template.

2. Select the alarm sources for the selected categories.
Note: In Steps 1 and 2, control-click to select multiple items, or check the Select All box.

3. To assign a different template for the selected alarm sources:
• Click on the drop-down menu and choose a template from the list. 
• Click the Change button.

• Click the View Selected Sources button to open a window showing the selected items, above 
right. Each source has a link to a details window and shows the currently assigned template.

• When finished, click the OK button (or Cancel to close the window without saving your changes).

Template
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8.8 Alarm Reports

The Reports tab in the Alarms window offers quick access to all alarm-related reports. These reports 
are also accessible from the Reports menu action button (see 10.0 - Viewing Reports).

To access reports from the Alarms window:

• Click the GEO button, then click on an item in the tree at left.
• Click the Alarms button, then the Reports tab.

• Click on a link to any of the alarm-related reports you want to view. The Reports window opens, 
as shown below, with the Reports button highlighted.

• If needed, click the View tab, then click the Run button to generate the report. When the report 
is displayed, you may copy the contents to a file by clicking the PDF, Excel or CSV Text button. 
See 10.3 - View Reports for details about this window. 

• Click the Options tab to view or change the report settings. See 10.4 - Set Up Report Options 
for details about this window.
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9.0 VIEWING TRENDS

The Trends button allows you to create trend graphs that may be viewed, printed or copied to a 
spreadsheet program. Liebert SiteScan Web can read and store equipment status values over time 
and then display this information in a graph to help you monitor the equipment's operation.

Trend data can be collected for any BACnet input or output point. The control module reads values for 
a point at intervals that you define and then stores that data in the module.

Because a control module has limited memory for storing trend data, you can set up historical 
trending to archive the trend data from the module to the Liebert SiteScan Web database. A trend 
graph can display data from both the control module and the database.

9.1 View an Existing Trend Graph

To view a trend graph:

• Click the GEO button in the bottom left corner, then select an item in the tree at left.
• Click the Trends button at the top of the window. (If more than one graph has been saved, click 

the Trends button down arrow and choose a graph.) If no graph appears, proceed to 9.2 - Create 
a New Trend Graph.

• Click View to display the graph. For tips on navigating the graph—zoom/pan, choose start dates, 
view point data—see 9.2.1 - Tools for Viewing Trends.

• Click the Print icon in the top right corner of the Trends window to print the graph.

GEO
button
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an item 
to view

Trends button
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9.2 Create a New Trend Graph

To create a new graph:

• Click the GEO button in the bottom left corner, then select an item in the tree at left. 
• If any graph has been saved for this item, click the Trends button down arrow, then select New 

Graph from the drop-down menu. (This step is not needed if no graphs have been saved.)
• A new tree appears in the center, allowing you to select up to 16 items for the trend graph. Use 

standard shift-click and control-click methods to select multiple items.
• Click View to display the graph. For tips on navigating the graph—zoom/pan, choose start dates, 

view point data—see 9.2.1 - Tools for Viewing Trends.
• Click Save to store the graph. In the popup window, enter a name as you want it to appear on the 

Trends drop-down menu. A reference name is created automatically. Click OK when finished.

9.2.1 Tools for Viewing Trends

Some tips for viewing trend graphs follow:

• A vertical dashed line indicates missing data.
• A large marker indicates a point that is in alarm, in fault, out of service or has been overridden. 

Control-click the marker to view details.
• Right-click anywhere on a trend graph to display a popup menu with tools described in Table 6. 

Click on an item in the menu—or use keyboard shortcuts shown in parentheses ( ) on the menu. 

• Table 6 shows commands available from the popup menu shown above and two other options. 
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Table 6 Tools for viewing trend graphs

Tool
Keyboard
Shortcut Notes

Pan 
left/right/up/ down

Arrow
keys 

If you display more than one graph, panning up and down affects only one 
graph at a time. Panning left to right affects all graphs. You can also Alt+click 
and drag inside the graph. 

Zoom in Page
Down

You can also use the plus (+) key on the numeric keypad, the X key, or drag a 
rectangle around area.

Zoom out Page
Up You can also use the minus (-) key on the numeric keypad or the Z key.

Zoom to extents Home
Shows all the data you have viewed in the current session of a particular trend 
graph.

Reset view End Resets the display to its default setting. You can also use the Enter or R key.

Undo Esc Undo up to 10 changes to your view.

Set start date J Enter the date you want the trend to jump to. The trend displays the same time 
range for the new date. Press the J key again to hide the date fields.

History Only H Displays only the historical data on the graph. 

Auto Update U The trend graph polls for data every 10 seconds. Press U again to stop 
updating.

Point Markers M Shows a marker for each data point in the graph.

Copy Ctrl+C Copies only the data from the time range that is currently displayed.

Other Options (not available on the popup menu)

Refresh the display 
(gather trend data) — Click the Trends button.

Display data for a 
specific sample —

Ctrl+click a sample to view the point name, time and date the sample was 
read, the exact point value, and if the point is in alarm, is in fault, out of 
service, or has been overridden. Click anywhere to clear the details.
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9.3 Configure Trends

Once a trend graph has been saved, the Configure tab appears in the Trends window, allowing you 
to specify options for the graph, such as changing the name, changing the appearance, adding or 
deleting points or selecting a different data source.

To configure a trend graph:

• Click the GEO button in the bottom left corner, then click on an item in the tree at left.
• Click the Trends button down arrow, then select a graph from the drop-down menu.
• Click the Configure tab.

• Set up the desired options for the trend graph.
• When finished, click the OK button to save any changes (or Cancel to leave without saving).
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10.0 VIEWING REPORTS

The Reports button offers a quick way to compile alarm and other information to help manage and 
troubleshoot your system. You may access existing reports (see Sections 10.1 - 10.4) or generate a 
custom report (see 10.5 - Set Up a New Report).

10.1 Description of Liebert SiteScan Web Reports

The reports available in Liebert SiteScan Web are described in Table 7.

Table 7 Description of available reports

Report Description

Alarms

Alarms View, sort and filter the information displayed in the Alarms View tab.

Alarm Sources Create a summary of potential alarm sources configured in the Alarms Enable/Disable tab.

Alarm Prefixes 
& Details Create a summary of the information configured in the Alarms Messages tab.

Alarm Actions Create a summary of the information configured in the Alarms Actions tab.

Schedules

Schedule 
Instances

Find every schedule entered at and below a selected tree item. This report shows the location 
of each item and can help you find newly added and conflicting schedules.

Effective 
Schedules

View all equipment that may be scheduled and the net result of all schedules in effect for a 
selected date and time.

Equipment

Point List
View the details of all points and verify that all points were checked out during commissioning. 
Create custom lists for other contractors, such as a list of BACnet IDs or Web services links. 

Locked Values Find all locked points and locked values.

Network IO
Verify the programming and status of all network points—especially useful for commissioning 
control modules used for third-party integration.

Trend Usage Create a summary of the information configured in the Trends Enable/Disable tab.

Parameter 
Mismatch

Find out whether your system has any parameter mismatches that need to be resolved.

Network

Equipment Status Display the thermographic color, status and prime variable of each control program.

Module Status Discover network communication problems (shown as purple squares on the report) that need 
troubleshooting.

Commissioning

Test & Balance View the results of VAV box commissioning.

Equipment 
Checkout

View the information on the Equipment Checkout tab of the Point Checkout tool during 
commissioning. Also, find equipment that has not been fully commissioned.

Security

Audit Log Create a chronological list of operators with property changes they have made and the 
reasons for those changes.

Security
Assignments

View a list of locations showing which operators are assigned to each location and their 
privilege sets.
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10.2 Finding Reports

To find a custom report, look for the  symbol on the GEO tree 

To edit or delete a report:

1. Select the item in the GEO or NET tree where the report was created.
2. Click the Reports menu drop-down arrow .
3. Select the report to be edited or deleted.

• To edit the report, make the changes and click OK.
• To delete the report, click the Reports menu button and click on Delete.

10.3 View Reports
• Click the GEO button in the bottom left corner.
• Click on an item in the tree at left—Data Center 2 in the example below.
• Click the Reports button at the top, then click on the View tab.

• To view an existing report, click on the Reports down arrow, then on a category. Choose a report 
from the submenu.

• Click the Run button below the View tab to generate a report.
• Once the report is displayed, you may copy 

the report contents to a file.

PDF

To create a PDF that may be opened with 
Adobe Reader or Acrobat:

• Click the PDF button. A program window 
displays the PDF. 

• Click the Save a Copy button to open the 
Save a Copy window, top right. 

• Specify where to save the file and a file 
name. Click the Save button.

Excel

To create a spreadsheet that may be opened 
with Microsoft Excel:Click the Excel button. If 
prompted whether to save or open, click Save 
to create a file.

• In the Save As window, center right, 
choose where to save the file and specify a 
file name. Click the Save button to 
download the file.

GEO
button

Click on 
an item 
to view

Reports button 
(click arrow for 
drop-down menu)

View 
tab

SAVE AS 
PDF

SAVE AS 
EXCEL FILE
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CSV

To create a CSV file that may be opened with a 
spreadsheet program or text editor:

Make sure the CSV feature is enabled (see 
10.4 - Set Up Report Options).

• Click the CSV Text button. If prompted 
whether to save or open, click Save to 
create a file.

• In the Save As window, bottom right, 
choose where to save the file and specify a 
file name. Click the Save button to download the file.

10.4 Set Up Report Options

The Reports Options tab permits customizing reports. For all report types, you may specify page 
size, orientation and maximum length. Other options vary by type of report.

To access the report Options functions:

• Click the GEO button, then click on an item in the tree at left.
• Click the Reports button, then the Report Options tab.

SAVE AS 
CSV FILE

Options
tab

Filter criteria

Report 
component 
selection

Printing details

Enable CSV 
export

Page Size Choices

Page 
Orientation
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• In the Printing details section:
• Specify the size of the report page by clicking the Page Size down arrow and selecting an 

option from the drop-down list—A2, A3, A4 Letter, Legal or 11x17 (see above).
• Choose the orientation by clicking on Portrait or Landscape; this determines the report’s 

appearance. The orientation should be chosen for reports that will be printed.
• Specify the maximum number of rows to appear in the report—the default, shown in the 

example above, is 1000. This may be helpful to reduce the size of reports you expect to be 
excessively long. If the length is exceeded, there will be a note of the report saying “maximum 
number of rows exceeded. This may be resolved by either filtering the report results or 
increasing the maximum number of rows permitted.

• The report output format is CSV, denoted by the check mark (✔) in the Support CSV text 
format box in the example above. This format permits using the report in many database 
programs. When this option is enabled, the CSV Text button is activated in the View tab (see 
10.3 - View Reports).

• In the Report component selection section (not available for all report types):
• For some report types, you may choose which report components to show or hide in the 

Display the following columns table. 
• Click to place a check mark (✔) for items you want to include; click to remove the check mark 

for items you want to omit. Some check boxes may be grayed-out; these items may not be 
changed.

• In the Filter criteria section (choices vary by report type):
• Many report types allow you to choose criteria to filter the report. In the example above, you 

may select the categories that contain the alarm sources you want to view. Control-click to 
select multiple items, or click to place a check mark (✔) in the Select All check box.

• For alarm reports, you may choose to include only those items that are currently in alarm. To 
do this, click to place a check mark (✔) in the Show only in alarm check box. (Leave the 
check box blank to include all items.)

• If there is an option to sort the report, click on the Sort By arrow and select an option from the 
drop-down menu—in the example above, Date or To Do.

• When finished, click OK (or Cancel to close the window without saving your changes).
• At any time, click on the Run button to view the report.

10.5 Set Up a New Report

In addition to the standard reports available from the Reports button drop-down menu, Liebert 
SiteScan Web provides three basic templates for you to design a new report:

• Equipment Summary
• Equipment Values*
• Trend Samples*

* Available with the optional Advanced Reporting package

Once a new report is set up, it appears on the Reports drop-down menu. See 10.3 - View Reports 
for details on all the functions available after the new report appears on the menu.

After creating a new report, the Options tab changes to the Design tab. At any time, you may select 
the report and click on the Design tab to make additional changes.
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To set up a new report:

• Click the GEO button, then click on an item in the tree at left.
• Click the Reports button arrow, then click on New Report in the drop-down menu. Steps are 

listed in red, as shown below.

10.5.1 Create a Report
1. Choose one of the report formats: Equipment Summary, Equipment Values or Trend 

Samples. Each format has a description and an example of the layout. 
2. In the Name box, enter a report name as you want it to appear on the Reports drop-down menu.

Note: If you have created report categories via the CFG Categories function, you may click on the 
Category arrow and select an option from the drop-down menu.

3. Click the Create button to create the new report. The Options tab label changes to Design. To 
design the new report, proceed to the next section, 10.5.2 - Design the New Report

Reports button 
(click arrow for 
drop-down 
menu)

Step 3

Step 2

Step 1
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10.5.2 Design the New Report

After you create a new report, click the Design tab to make changes to the format, as shown below.

• The top center portion of the window displays the report type and name. You may change the 
report name in the Title box below the Run button.

• The Design tab displays the same choices as the Options tab (see 10.4 - Set Up Report Options) 
for page size, orientation, maximum number of rows and enabling support for CSV.

• Each custom template provides additional options that vary by report type. The example above 
shows the design options for the Equipment Summary report.

• When finished, click OK to save your changes (or Cancel to close the window without saving).
• At any time, click on the Run button to display the report in the View tab. The example below 

shows the Equipment Summary report.

10.6 Built-In Reports

Standard reports appear throughout the system, though their function changes depending on where 
in the GEO tree or NET tree the report is run. If a report is run on a single unit in the GEO tree, the 
report will contain results from only that unit. Moving up to an area and running a report that will 
yield results from all the units in that area. A report run at the root of the system will contain results 
from the entire system.

These built-in reports are not marked with the  symbol.

Design 
Tab

View 
Tab
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10.6.1 Report Options

Clicking on the Design tab permits filtering the information displayed in a report. This can be used to 
limit the size of the report and its layout.

Optional Columns

Many reports have optional columns, some of which may not be needed. When working with an 
unfamiliar report, running a test report with all columns activated will permit see the sort of 
information each field returns.

Optional Rows

Many reports also have optional rows that are described as filter criteria. For example, the Location 
Audit Log can be filtered to show results from only one operator, administration and system changes 
or could restrict results to a date range. These can be combined. For example, a report could specify 
an operator and a date range.

10.7 Equipment Checkout

 View the information on the Equipment Checkout tab of the equipment’s Properties page. Also, find 
equipment that has not been fully commissioned. Not all installing technicians use these reports, if 
they are blank, ask the technician for their commissioning notes.

10.8 Alarms

View, sort, and filter the information on the Alarms View tab. The report will be empty if there are no 
alarms recorded for a piece of equipment.

10.8.1 Alarm Sources

Create a summary of potential alarms. The list will help familiarize operators with the equipment by 
listing all the alarms a piece of equipment might generate.

Optional field 
disabled, not 
shown in report
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10.8.2 Alarm Prefixes and Details

Create a summary of the information configured on the Alarms > Messages tab. To determine where 
these are configured in the system, run this report in the root of the GEO tree.

10.8.3 Alarm Actions

Create a summary of the information configured on the Alarms > Actions tab. Also useful to find 
where these are configured in the system, just run this report in the root of the GEO tree. 
Additionally, if you are merely looking for where an alarm action is defined, look for this symbol  
in the GEO tree. 

10.9 Equipment

10.9.1 Locked Values

Find all locked points and locked values. A common way to test alarms is to lock a point to an alarm 
condition, you can verify they are cleared and will respond normally with this report. It is very rare to 
have a normal situation where a point is locked all the time. 

10.9.2 Network IO

Verify the programming and status of all network points-especially useful for verifying third-party 
integration points are reading with no errors. If you get a loss of communication alarm from a third 
party device this report can help you define what the trouble is. Detailed information on point read 
errors is generally located in the control module under driver, protocols, error definitions. When you 
are looking at an equipment on the GEO and you need to quickly get to the control module it is in run 
manual command go ~net and the system will take you to that equipment on the NET tree. 

10.9.3 Trend Usage

Creates a summary of the information configured on the Trends > Enable/Disable tab.

10.9.4 Parameter Mismatch

Discover where your system has parameter mismatch between the database and the field controllers 
that need to be resolved. Contact Liebert Services if you have persistent problems with parameter 
mismatches. 

10.10 Security

10.10.1 Location Audit Log

View chronological lists of location-based changes, the operators that made them, and the reasons for 
the changes. This report includes changes such as property edits, downloads, driver changes, and 
view changes. 

10.10.2 System Audit Log

View chronological lists of system-wide changes, the operators that made them, and the reasons for 
the changes. This report includes changes such as any change made in the CFG tree, login/logout, and 
scheduled processes like deleting expired trends

10.11 Network (Only on NET Tree)

10.11.1 Equipment Status

Display the unit alarm color, status, and prime variable of each control program. It is normal for 
Liebert SiteScan Web to not utilize the prime variable.

NOTE
Reason field will be empty unless system is configured to require operator notes when making 
changes. Contact Emerson Network Power Liebert Services to enable this feature.
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10.11.2 Controller Status

Discover network communication problems (shown as purple squares on the report) that need 
troubleshooting. The report also shows the boot and driver version, download information and 
whether the controller has 4.x or later driver. The report shows the serial number and Local Access 
port status. The Controller Status is helpful when dead module alarms have been generated and 
Liebert SiteScan control module communication on the network must be verified.
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11.0 CONFIGURING LIEBERT SITESCAN WEB

Most of the configuration for Liebert SiteScan Web is performed by Liebert Services. This section 
provides instructions on how to change the most commonly used configuration settings.

11.1 My Settings

My Settings has two tabs—Settings and Contact Info—that apply to the user currently logged in.

11.1.1 Settings

• Click on the CFG button, then click on My Settings in the tree at left.
• Click on the Settings tab to display the following window.

Change Password

To change the login password:

• In the Login section, click to place a check mark (✔) in the Change Password box.
• Enter the existing password in the Current Password box.
• Enter the new password in the New Password box. The password is case-sensitive.
• Confirm the new password by re-entering it in the Retype New Password box.

Change Starting Location

To specify the opening view for Liebert SiteScan Web after you log in:

• Click on an item in the tree below Starting Location. Click the plus (+) sign to expand an item.
• Click on the view button—e.g., GEO or CFG—to be active when Liebert SiteScan Web starts.
• Click on the Starting Page arrow and select an option from the drop-down menu to determine the 

menu action button—e.g., Graphics or Alarms—to be active when Liebert SiteScan Web starts.

Change Preferences

• The Language box has a drop-down menu of available languages. To set up your system for a 
language other than English, see the Help file for detailed procedures.

• Click to place a check mark (✔) in the Automatically collapse trees box to expand only one tree 
branch at a time.

• You may specify a custom sound file (with the extension .au or .wav) for each alarm type. Click to 
place a check mark (✔) in the alarm type box—Non-critical alarms or Critical alarms—and 
enter the file name with its path in the corresponding Sound File text box.

Save Changes
• When finished, click OK (or Cancel to close the window without saving your changes).
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11.1.2 Contact Info

• Click on the CFG button, then click on My Settings in the tree at left.
• Click on the Contact Info tab to display the following window.

• Enter your contact information in the text boxes: 
• Enter telephone numbers for Home, Work, Cell, Fax and Pager.
• Enter your work location in the Address box.

• When finished, click OK (or Cancel to close the window without saving your changes).

11.2 System Settings

This section describes two tabs in System Settings: General and Daylight Saving.

11.2.1 General

• Click on the CFG button, then click on System Settings in the tree at left.
• Click on the General tab to display the following window.

• The General tab displays several items that are not editable: System Directory Name, Current 
System Time, Path to the Web Root Directory, Database Type, System Language

• Choose the Time Format: 12-hour clock (4:34 pm) or 24-hour clock (16:34).
• Choose the Date Format—for example, mm/dd/yy.
• The Node Name Display Depth box shows the number of levels displayed in paths in Liebert 

SiteScan Web. For example, if this value is set at:
• 2, a typical path might be ..\First Floor\AHU
• 3, a typical path might be ..\Atlanta R&D\First Floor\AHU

Changing this field does not take effect until you restart the Liebert SiteScan Web server.
• Use a single alarm template for CMnet alarms applies to upgraded legacy systems:

• Check the box to use the alert_auto alarm template only CMnet equipment alarms.
• Leave the box unchecked to allow multiple alarm templates.

• In the Logs section, you may download a zip file with logs of system activity for a specified week. 
Choose a beginning date in the Select a week of logs to review drop-down list, then click the 
Download button.
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11.2.2 Daylight Saving

• Click on the CFG button, then click on System Settings in the tree at left.
• Click on the Daylight Saving tab to display the following window.

• The Offset for Daylight Saving time should be 1 hour, using the format HH:MM (01:00).
• Daylight Saving Start Time is typically 2:00 a.m. Enter in the format HH:MM:SS (02:00:00), then 

click on the AM/PM box to toggle between AM and PM.
• Daylight Saving Dates should have Begin and End dates for each year. Click on a calendar icon, 

then click on a date in the calendar, shown above right, or enter the date in mm/dd/yyyy format.

11.3 Set Up Users

The Administrator may set up users, defined as Operators in Liebert SiteScan Web, with customized 
access privileges. These operators may also be designated as recipients of alarm messages, as 
described in 8.4 - Actions.

Users may be assigned to Operator Groups to simplify the process of assigning access privileges and 
setting up recipients for alarm messages, as described in 11.3.2 - Create Operator Groups.

11.3.1 Set Up Operators

The Operators window allows you to add, edit or delete users and assign access privileges.

• Click on the CFG button, then click on Operators in the tree at left.
• Click the Add button to create a new user or click on an existing user in the Operators list. The 

operator’s data appears to the right.

• To remove an existing user, click the Delete button.

NOTES
Liebert SiteScan Web has a default Administrator operator. For security, either assign a 
password to this operator or delete it after assigning Admin privileges to another operator.
With hierarchical servers, you must create identical operators on each server.
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• In the Login section:
• In the Name box, enter a name that will appear in lists in Liebert SiteScan Web.
• In the Login Name box, enter a name for the operator to enter when logging in. This name 

must be unique within the system.
• To assign a new password, check (✔) Change password, then refer to 11.1 - My Settings.
• To prompt a user to create a password, check Force user to change password at login box. 

Be sure to assign a temporary password.
• Specify whether to use automatic logoff for this user: after 15 minutes of inactivity, a different 

time (up to 500 hours maximum) or not at all.
• Complete the Personal Information for this user (see 11.1.2 - Contact Info for details).
• Specify the Starting Location when this user logs in (see 11.1.1 - Settings for details).
• In the Privilege section:

• To assign access privileges to the user, check (✔) appropriate boxes under System-Wide 
Privilege Sets (see 11.4.1 - Add a Privilege Set).

• To assign the user to any groups, check (✔) appropriate boxes under Groups (see 11.3.2 - 
Create Operator Groups). The user will have the same privileges as the group.

Note: To hide items not assigned to this user, check (✔) Show current privileges only. A 
grayed-out privilege set indicates it was assigned to the operator through a group listed next to 
the privilege—for example, Admin From Reps.

• When finished, click OK (or Cancel to close the window without saving your changes).

11.3.2 Create Operator Groups
Users may be assigned to Operator Groups to simplify the process of assigning access privileges and 
setting up recipients for alarm messages. This step requires that individual operators have been 
created, as described in 11.3.1 - Set Up Operators.

• Click on the CFG button, then click on Operator Groups in the tree at left.
• Click the Add button to create a new group or click on an existing group in the Name list. The 

group’s data appears to the right. 

• To remove an existing group, click the Delete button.
• In the Display Name box, enter a name that will appear in lists in Liebert SiteScan Web.
• Enter a system name in the Reference Name box. The reference name must consist of 

alphanumeric and underscore characters only and may not begin with a numeral.
• In the Members section, check (✔) each existing individual operator under Operators you wish 

to add to the group. You may also add another group by checking boxes under Groups.
• To assign access privileges to the group, check (✔) appropriate boxes under Privilege Sets (see 

11.4.1 - Add a Privilege Set).
• When finished, click OK (or Cancel to close the window without saving your changes).

NOTE
Liebert SiteScan Web has a permanent default group called Everybody that automatically 
includes all operators as members. You may assign privilege sets to this default group.
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11.4 Assign Privileges to Users

You may create Privilege Sets—permission to use selected features in Liebert SiteScan Web—and 
assign them to individual operators and operator groups.

11.4.1 Add a Privilege Set

• Click on the CFG button, then click on Privilege Sets in the tree at left.
• Click the Add button to create a new set of privileges or click on an existing set. The set’s data 

appears below the button.

• To remove an existing privilege set, click the Delete button.
• Choose the type of privilege set: System-wide (available to assign to other users) or Local. Each 

option brings up a corresponding list of privileges from which to choose.
• System-wide privileges include access and functional privileges. 

These privilege sets may be assigned to other users in the Operators window (see 11.3.1 - Set 
Up Operators) and Operator Groups window (see 11.3.2 - Create Operator Groups).

• Local include access, parameter and functional privileges.
Note: Once a privilege set is created, the only way to change the type is to delete the set and 
create a new one.

• In the Name box, enter a name that will appear in lists in Liebert SiteScan Web.
• Enter a system name in the Reference Name box. The reference name must consist of 

alphanumeric and underscore characters only and may not begin with a numeral.
• Click to place a check mark (✔) for each privilege you want to include in this privilege set. Refer to 

Table 8 for a complete list of privileges with descriptions.
• When finished, click OK (or Cancel to close the window without saving your changes).

NOTE
Liebert SiteScan Web comes with a default privilege set called Admin that includes most 
privileges. Only an operator with the Admin privilege set can perform the following functions 
that are not controlled by privileges:

• Add, edit and delete operators, operator groups and privilege sets.
• Update Liebert SiteScan Web Server.
• Register the Liebert SiteScan Web license.
• Enable and set up advanced security features such as location-dependent operator access 

and a configurable password policy (if included in your system).



Configuring Liebert SiteScan Web

Liebert® SiteScan Web™ 65

Table 8 provides descriptions for all privileges available in the Privilege Sets window.

Table 8 Privilege descriptions

Access Privileges Operators may access (but not edit):

Access Geographic Locations Pages from the GEO tree.

Access Network Items Pages from the NET tree.

Access Groups Pages from the GRP tree.

Access Config Items Pages from the CFG tree.

Access Alarms Alarms.

Access Logic Pages Logic pages.

Access User Category 
(1-5)

Anything in a category that has the same privilege assigned to it. 
Note: These categories may be used to create a custom privilege:
• You can assign a privilege to a Graphic, Property, Trend, or Report 

category so that only operators with that privilege can access the 
category. You assign a category privilege on the page where you 
create or edit categories.

• If all the other privileges are too widely used to accomplish the results 
you want, you can assign one of the five Access User Category 
privileges to the operators and category.

Parameter Privileges Operators may edit properties such as:

Edit Setpoint Parameters Occupied and unoccupied heating and cooling setpoints.

Edit Tuning and Logic Parameters
Gains, limits, trip points, hysteresis, color bandwidths, design 
temperatures and optimal start/stop.

Edit Manual Override Parameters Locks on input, output and network points.

Edit Point Setup Parameters Point number, type, range and network source and destination.

Edit Restricted Parameters Properties the installer restricted with this privilege.

Edit Category Assignments Alarm, Graphic, Trend and Report category assignments.

Edit History Value Reset Elapsed active time and history resets and runtime hours.

Edit Trend Parameters Enable trend logging, log intervals and log start/stop times.

Edit Calibration Parameters Point calibration offsets.

Edit Hardware Device Parameters Module driver properties.

Edit Critical Configuration Critical properties the installer protected with this privilege.

Edit Area Name Area display names.

Edit Equipment Name Equipment display names.

Edit Alarm Configuration
Enabling/disabling alarms and editing alarm messages, actions, 
categories and templates.

InterOp Privilege 1 - 10 Those protected by password levels 1-10 in SiteScan 2000.

Functional Privileges Operators may:

Manage Alarm Messages and Actions Add, edit and delete alarm messages and actions.

Maintain System Parameters Edit all properties on the System Settings page.

Maintain Schedules Add, edit, delete and download schedules.

Maintain Schedule Group Members Add, edit and delete schedule groups.

Maintain Categories Add, edit and delete categories.

Maintain Trends Display and Print 
Setup

Edit Trends Display Setup and Trends Print Setup on the CFG tree.

Maintain Alarm Templates Edit Alarm Template and Reporting Action Templates.

Acknowledge Non-Critical Alarms Acknowledge all non-critical alarms.

Acknowledge Critical Alarms Acknowledge all critical alarms.
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Functional Privileges (continued) Operators may:

Force Normal Non-Critical Alarms Force non-critical alarms to return to normal.

Force Normal Critical Alarms Force critical alarms to return to normal.

Delete Non-Critical Alarms Delete non-critical alarms.

Delete Critical Alarms Delete critical alarms.

Execute Audit Log Report Run the Audit Log Report.

Download Devices Mark equipment for download and initiate a download.

System Shutdown
Issue the Shutdown manual command that shuts down Liebert SiteScan 
Web Server.

Engineer System

• Log in and make database changes in SiteBuilder.
• Use the copy, notify, reload and revert manual commands.
• Access the Configure and Set up Tree right-click menus in Liebert 

SiteScan Web.
• Add text in the Notes field on an equipment’s Properties page.

Access Commissioning Tools

Access:
• Equipment Checkout
• Airflow Configuration
• Trend, Report and Graphic categories that require this privilege
• Discovery tool

Maintain Graphs and Reports Add, edit and delete trend graphs and reports.

Maintain Connections Edit Connections page properties.

Remote File Management Access files using a WebDAV utility.

Remote Data Access-SOAP Retrieve data through an Enterprise Data Exchange (SOAP) application.

Do not audit changes made
using SOAP (Web services)

Not have SOAP (Web services) changes recorded in the Audit Log.

Manual Commands/Console 
Operations

Access the manual command dialog box and issue basic manual 
commands.

Manual Commands/File IO Execute manual commands that access the server’s file system.

Manual Commands/Adv Network
Execute manual commands that directly access network 
communications.

Manual Commands/Unrestricted
Execute manual commands that bypass all safeguards and may cause 
unpredictable results if used incorrectly.

Table 8 Privilege descriptions (continued)
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11.5 Services

The Services window displays all current services for Liebert SiteScan Web and the status of each.

To access the Services window:

• Click on the CFG button, then click on Services in the tree at left.
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11.6 Trends Setup

11.6.1 Trends Display Setup
The Trends Display Setup options allow you to specify the appearance of graphs on the screen.

• Click on the CFG button, then click on Trend Display Setup in the tree at left.

• In the Trend Colors section, choose options to specify colors for all graphs for the background, grid 
and axis, as well as text portions: labels for x-axis and y-axis labels, the main title and the y-axis 
title.

• You may set up display options for up to four types of graphs, including line style and color and 
marker color and type.

11.6.2 Trends Print Setup
The Trends Print Setup options allow you to specify the appearance of graphs on the printer.

• Click on the CFG button, then click on Trends Print Setup in the tree at left.

• In the Trend Colors section, choose options to specify colors for all graphs for the background, grid and 
axis, as well as text portions: labels for x-axis and y-axis labels, the main title and the y-axis title.

• You may set up display options for up to four types of graphs, including line style and color and 
marker color and type.
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11.7 Client Installs

Client Install is used to install the Java Virtual Machine on the current connected workstation. 
Install only if required.

Wafer Font is used by Liebert SiteScan Web to display specific text in the Liebert SiteScan Web 
session. Install only if required.

Alarm Pop Application is a thin application that can be used by a client to receive alarm 
notifications to a workstation outside of the Liebert SiteScan Web browser.

To access these downloads:

• Click on the CFG button, then click on Client Installs in the tree at left.

Click a link to download:

• Sun’s Java VM: Java Virtual Machine plug-in for Internet Explorer applets.
• Wafer font: Wafer font for use with logic pages. (Place in your Windows install directory/fonts 

folder.)
• Alarm Popup Application: Stand-alone client application that receives Alarm Popup action 

messages.
• HTTP proxy tool: Engineering tool to tunnel web pages across BACnet (through RNet or access 

port).

11.8 Changing Unit Bezel Colors
1. On the top level floor plan in the GEO tree, select Bezel Color Scheme from the Graphics drop-

down menu.
2. The color drop-down menu under Scheme Selection offers several colors and Custom. Gray is 

selected by default. To change colors, select either a color or Custom from the drop-down menu 
(see below, right).

Select Bezel 
Color scheme

In the dialog box 
that opens, choose 
a color or choose 
Custom
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Choosing a Color in Scheme Selection for the Entire Bezel

Selecting a color from the drop-down menu will apply a color scheme based on that color to the table 
header, bezel background and table background. Light Yellow was selected in the example below, 
making the entire bezel varying shades of light yellow. Choosing Custom permits selecting different 
colors for various elements of the unit bezel.

Choosing Different Colors for Elements of the Bezel

The Custom color selection permits setting different colors for each of these bezel elements:

• De-Selected Tab
• Table Header
• Bezel Background
• Table Background
• Summary Lines

To change individual elements of the bezel, select Custom from the Scheme Selection drop-down 
menu. This brings up a dialog box with standard colors and a Custom option that will display a color 
wheel with a chromatic scale of 4096 colors.

To change the color of a portion of the bezel, click on the arrow associated with the name of the bezel 
element.

Choosing Light Yellow 
here makes the entire 
bezel light yellow.

Choosing Custom enables drop-down 
lists for selecting colors for various 
parts of the bezel
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If a desired color is not available, select New from the drop-down color list. This prompts Liebert 
SiteScan Web to display a color wheel. Use the cursor to select a color and click Save Scheme.

Summary Line Colors

Summary lines are used to change the colors of the summary views that Liebert SiteScan Web 
displays—Area, Unit, Air, Power and UPS. Selecting red in the next example yields the red lines in 
the example below. 

Choosing red for the 
Summary Lines ...

... changes the lines in the 
summary pages to red.
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11.9 Event Color Scheme

Changing the alarm colors can only be performed by a person with administrative privileges in 
Liebert Site Scan Web. Changing the event color scheme may also require downloading a module.

To change the alarm colors:

1. On the top level floor plan in the GEO tree, click the arrow beside Graphics and choose Event 
Color Scheme from the drop-down menu. This brings up the Event Selection dialog box with the 
default colors displayed for each choice, see below.

The Event Selection offers two options: Default and Custom. Default sets the colors to the 
standard colors of Liebert SiteScan Web. Selecting Custom permits changing the colors.

2. Select Custom to change the colors. The example below shows green selected for Critical 
Warnings.
This will change all Critical Warnings for all users to green.

3. Click Save Event Color to save the colors chosen.
This will bring up confirmation popups. To make the color changes, click OK each time. Making 
the color change may take more than two minutes, depending on the size of the system.

NOTE
Alarm colors are a System setting. Changing a System setting, such as alarm colors, 
will affect all users.

If any user changes the event color scheme it will overwrite the previous setting.

NOTE
If the event color scheme does not take effect, a module download may be required. Contact 
your IT department to download the module.

Critical Alarm 
Default Color: Red

Warning Alarm 
Default Color: Yellow

Message
Default Color: Blue

Maintenance
Default Color: Gray
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12.0 LIEBERT SOFTWARE PROGRAM LICENSE AGREEMENT

This section contains the license agreement for Liebert SiteScan Web.

LIEBERT SITESCAN WEB SOFTWARE LICENSE AGREEMENT

Liebert Corporation
End User License Agreement (EULA)

This End User License Agreement (EULA) is a CONTRACT between the User, and Liebert Corporation 
(Liebert), which covers the User's use of the Liebert products (Products) that accompany this EULA, 
which may include software programs (Software), hardware (Hardware), associated media, printed 
materials, and "online" or electronic documentation. If the User does not agree to the terms of this 
EULA, then do not install or use the Software Product or the License. BY EXPLICITLY ACCEPTING 
THIS EULA, HOWEVER, OR BY INSTALLING, COPYING, DOWNLOADING, ACCESSING, OR 
OTHERWISE USING THE SOFTWARE PRODUCT AND/OR LICENSE, YOU ARE 
ACKNOWLEDGING AND AGREEING TO BE BOUND BY THE TERMS OF THIS EULA.

COPYRIGHT

Copyright laws and international copyright treaties, as well as other intellectual property laws and 
treaties protect the Products. User may not and shall not copy or otherwise reproduce or make 
available to any other party any part or all of the Products. The User may, however, make one (1) copy 
of Software for backup or archival purposes.

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS

User may not reverse engineer, decompile or disassemble the Products, modify or create derivative 
works based upon the Products in whole or in part, distribute copies of the Software, remove any 
proprietary notices or labels on the Products or resell, lease, rent, transfer, sublicense or otherwise 
transfer rights to the Software. User acknowledges that no title to the intellectual property in the 
Products is transferred. Title, ownership, rights and the intellectual property rights in and to the 
Products shall remain with Liebert. Furthermore, this EULA does not grant User any rights in 
connection with any trademarks or service marks of Liebert.

GRANT OF NON-EXCLUSIVE LICENSE

Liebert Software that does not require registration (typically engineering tool software programs and 
training software programs) may be installed and used on multiple computers within the User's 
organization as required, but may not be shared with individuals outside the User's organization. User 
may not modify or create derivative copies of the License. User may not sublicense, reassign, or 
transfer this License or Agreement, or any part thereof, to any party. All rights not expressly granted 
to User are retained by Liebert.

WARRANTIES

Licensor warrants that Licensor has the right to license to User the nonexclusive use of the Products as 
set forth herein. Licensor warrants that, to the best of Licensor’s knowledge, the intellectual property 
embodied in the Products do not infringe upon the registered U.S. copyright, patent, or trademark 
rights of third parties. ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE ARE 
HEREBY EXCLUDED.

INDEMNIFICATION

In the event of any United States copyright, patent, or trademark infringement claim brought against 
User arising out of use of the Product as authorized in this EULA, Licensor will defend, at its expense, 
and pay any direct costs and damages made in settlement or finally awarded as a result of any 
infringement action brought against User, subject to the limitations set out in the next paragraph, 
provided (1) Licensor is promptly notified in writing by User that such action is threatened or has been 
brought; (2) Licensor shall have sole control of the defense of any such action and all negotiations for its 
settlement or compromise; and (3) Licensor receives the cooperation and assistance of User.

(continued)
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LIMITATION ON LIABILITY

Licensor shall not be liable for loss of profit, loss of business, or other financial loss which may be 
caused, directly or indirectly, by the inadequacy of the Product for any purpose or any use thereof, or by 
any defect or deficiency therein. The User agrees that the Licensor’s liability for damages, if any, shall 
not exceed the charges paid to the Licensor by the User under this Agreement. No action, regardless of 
form, arising out of any transaction under this Agreement may be brought by the User more than one 
year after the Licensee has knowledge of the occurrence which gives rise to the cause of such action.

ADDITIONAL SOFTWARE

This EULA applies to updates or supplements to the original Product provided by Liebert.

TERMINATION

Liebert may cancel this EULA if User does not abide by the terms and conditions of this EULA, in 
which case all Products and component parts must be returned to Liebert and all copies of Products, or 
any portions thereof, not returned to Liebert, must be destroyed.

NOTE ON JAVA SUPPORT.

Sun Microsystems, Inc. has contractually obligated Liebert to make this disclaimer:

THE PRODUCT MAY CONTAIN SUPPORT FOR PROGRAMS WRITTEN IN JAVA. JAVA 
TECHNOLOGY IS NOT FAULT TOLERANT AND IS NOT DESIGNED, MANUFACTURED, OR 
INTENDED FOR USE OR RESALE AS ONLINE CONTROL EQUIPMENT IN HAZARDOUS 
ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF 
NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR 
TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH 
THE FAILURE OF JAVA TECHNOLOGY COULD LEAD DIRECTLY TO DEATH, PERSONAL 
INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ENTIRE AGREEMENT.

This EULA, including any addendum or amendment to this EULA which is included with the Product, 
are the entire agreement between User and Liebert relating to the Products, and they supersede all 
prior or contemporaneous oral or written communications, proposals and representations with respect 
to the Products or any other subject matter covered by this EULA. To the extent the terms of any 
Liebert policies or programs for support services conflict with the terms of this EULA, the terms of this 
EULA shall control.

CONTACT INFORMATION

If the User has any questions about this EULA, or wants to contact Liebert for any reason, please direct 
all correspondence to: Liebert Corporation, Attn: Marketing Department, 975 Pittsburg Drive, 
Delaware, OH 43015, United States of America.

© 2003 Liebert Corporation

LIEBERT SITESCAN WEB SOFTWARE LICENSE AGREEMENT (continued)
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Notes
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